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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for technical or editorial errors or 
omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. 
Government under vendor's standard commercial license.

Third-Party Web Sites

HP provides links to external third-party Web sites to help you find supplemental 
information.  Site content and availability may change without notice.  HP makes no 
representations or warranties whatsoever as to site content or availability.

Copyright Notices

©  Copyright 2002 - 2008 Mercury Interactive (Israel) Ltd.

Trademark Notices

Intel® is a trademark of Intel Corporation in the U.S. and other countries.

Java™ is a US trademark of Sun Microsystems, Inc. 

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation. 

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California. 

UNIX® is a registered trademark of The Open Group. 



3

Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals

http://h20230.www2.hp.com/selfsolve/manuals


4

Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
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Welcome to This Guide

Welcome to the HP Performance Center System Configuration and Installation 
Guide. This guide describes how to install and configure the HP Performance 
Center components.

Performance Center is HP’s Web-enabled global load testing tool, which is 
specially designed to streamline the testing process and increase the test 
efficiency for multiple concurrent load tests across multiple geographic 
locations.

This chapter includes:

 ➤  How This Guide Is Organized on page 10

 ➤  Who Should Read This Guide on page 11

 ➤  Performance Center Online Documentation on page 11

 ➤  Additional Online Resources on page 11
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How This Guide Is Organized

This guide contains the following parts:

 Part I Getting Started

Provides you with the information that will help you prepare for the 
Performance Center installation process, including system requirements.

 Part II Windows Installation

Describes how to install and configure the Performance Center components 
on a Windows machine.

 Part III UNIX Installation

Describes how to install a load generator on a UNIX platform.

 Part IV Upgrade

Describes the steps that you need to carry out when upgrading to HP 
Performance Center 9.10.

 Part V Configuration

Describes the required configuration steps that you need to carry out after 
you install Performance Center and also includes recommended 
configuration settings for your system.

 Part VI Using Firewalls in Performance Center

Describes how to set up your Performance Center system to run Vusers and 
monitor servers over a firewall.

 Part VII Troubleshooting

Provides troubleshooting tips and information for Performance Center 
problems.
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Who Should Read This Guide

This guide is intended for users who need to install and configure
HP Performance Center.

Readers of this guide should have some knowledge of system 
administration.

Performance Center Online Documentation

HP Performance Center includes the following online documentation:

Readme provides last-minute news and information about Performance 
Center. You access the Readme from the Start menu.

What’s New gives a brief description of the new features in this release of 
Performance Center, including links to video walkthroughs. Select 
Miscellaneous > What’s New in the User site.

Books Online/Printer-Friendly Documentation includes printable versions 
(PDF) of the Performance Center guides. Select Start > Programs > HP 
Performance Center > Documentation and select the relevant book.

HP Performance Center Online Help is available by clicking the Help button 
at the top of the Performance Center site page or in a dialog box.

Additional Online Resources

Troubleshooting and Knowledge Base accesses the Troubleshooting page on 
the HP Software Support Web site where you can search the Self-solve 
knowledge base. The URL for this Web site is 
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. The URL for this Web site is 
www.hp.com/go/hpsoftwaresupport.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
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Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. The URL for this Web site is www.hp.com/go/software.

http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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1
Before You Install

This chapter provides you with the information that will help you prepare 
for the Performance Center installation process. Before you install 
Performance Center, you must review the system requirements.

This chapter includes:

 ➤  Installation Flow on page 16

 ➤  Performance Center Components and Data Flow on page 17

 ➤  System Component Requirements and Considerations on page 22

 ➤  Pre-installation Considerations: All Components on page 32

 ➤  Required Services on page 34

 ➤  Browser Configuration on page 35
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Installation Flow

The diagram below provides an outline of the steps involved in installing or 
upgrading to HP Performance Center 9.10 and includes references to the 
relevant parts in the book.

New 
InstallationUpgrade

Uninstall/clean
Part IV: Upgrade

Review pre-installation requirements
Part I: Getting Started

Back up data
Part IV: Upgrade

Migrate data
Part IV: Upgrade

Install Windows/Unix components
Part II: Windows Installation

Part III: Unix Installation

Configure system
Part V: Configuration

New Installation
or Upgrade
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Performance Center Components and Data Flow

This section describes the HP Performance Center components.

➤ Administration Site. The Administration Site is used for administering the 
Performance Center system. From the Administration Site, you can perform 
tasks such as assigning user roles and privileges, creating and administering 
projects, and managing resource usage.

➤ User Site. The User Site is used for creating, managing, and running load 
tests. From the User Site, you can perform tasks such as designing and 
configuring load tests, configuring monitors, reserving resources, running 
and monitoring test runs, and analyzing test results.

➤ Utility Server. The Utility Server is the Performance Center License Manager 
and is also used for configuring monitor profiles and other maintenance 
services.

➤ Database and File Servers. The Database and File Servers form the 
infrastructure for persistent data within Performance Center. The Database 
Server stores information on users, projects, host information, and load 
tests. The file server stores the test scripts and test results.

➤ Performance Center Host. Performance Center hosts are used to control 
load tests, generate load, and analyze data. Performance Center hosts can be 
configured as Controllers, Load Generators, or Data Processors:

➤ Controller. The Controller is the manager of a load test. The Controller 
receives the scripts, their run-time settings, and a list of the load 
generators to use. The Controller issues instructions to the load 
generators including which scripts to run, how many Vusers to run per 
script, and scheduler settings. At the conclusion of the test run, the 
Controller collates the data. There is only one Controller per load test.

➤ Load Generator. Load generators generate load by running Vusers. The 
Controller dictates the manner in which they start and stop running. 
There can be any number of load generators for a given load test. 

➤ Data Processor. The Data Processor host is used for publishing 
information to the Performance Center Dashboard.
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➤ MI Listener. The MI Listener is one of the components needed to run Vusers 
and monitor applications over a firewall. For more information about 
firewalls in Performance Center, see Part VI, “Using Firewalls in Performance 
Center.”

➤ Monitors Over Firewall. Used to monitor servers that are located over a 
firewall. For more information about firewalls in Performance Center, see 
Part VI, “Using Firewalls in Performance Center.”

The following standalone applications, which are included on the 
Performance Center installation disk, integrate with your Performance 
Center System:

➤ HP Virtual User Generator. Virtual User Generator (VuGen) generates virtual 
users, or Vusers, by recording actions that typical end-users would perform 
on your application. VuGen records your actions into automated Vuser 
scripts which form the foundation of your load tests. 

➤ HP Analysis. HP Analysis provides graphs and reports with in-depth 
performance analysis information. Using these graphs and reports, you can 
pinpoint and identify the bottlenecks in your application and determine 
what changes need to be made to your system in order to improve its 
performance.

➤ SiteScope. SiteScope is a data collector used for collecting performance data 
from network, application, database, and Web servers.

➤ ERP and CRM Mediator. The ERP and CRM Mediator gathers and correlates 
offline transaction data for the ERP/CRM diagnostics modules. 

Communication Paths
When installing Performance Center, it is important to consider the 
communication paths between, and the resource demands of, the various 
components. This information helps you configure your system to evenly 
distribute the load and prevent overloading any particular resource.

When running a load test, the Performance Center system components 
share information via a distinct system of communication. Understanding 
which components communicate with one another and the method of 
communication is essential for configuring your system.
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The following diagram illustrates the communication paths and protocols of 
the Performance Center system:

Note: Some communication protocols (ADO and NetBIOS) should not be 
used with a firewall. Keep this in mind when configuring a system with a 
firewall. For more information on firewalls, see Part VI, “Using Firewalls in 
Performance Center.”

For more detailed information about the communication paths and 
protocols and a list of Performance Center processes and services, refer to 
the HP Performance Center Troubleshooting Guide.

Database
Server

Administration
Site

User
Site

Utility
Server

File
Server

Controller
Host Machine

ADO

ADO

WS

NetBIOS

WS
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Communication between Components
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TCP/IP



Chapter 1 • Before You Install

20

Load Considerations
The following table provides some basic installation considerations for each 
Performance Center component:

Machine
Quantity 
within the 
system

Load Considerations

Administration 
Site

One Light load.

Can be installed on the same machine as the 
User Site

User Site At least one Heavy load

Can be installed on the same machine as the 
Administration Site.  

To balance the load on your Performance Center 
system you can install multiple User Sites and 
use load balancers that route traffic based on 
ASP Session IDs.

Database 
Server

One Light load

Can be installed on the same machine as the File 
Server. 

Standalone installation is recommended.

File Server One Light load

It is recommended to install the File server on a 
machine with a reliable hard drive and a fast 
network connection. 

Can be installed on the same machine as the 
database server. 

Utility Server One Generally light load with heavy spikes during 
Monitor configuration

Standalone installation is recommended 
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Host

➤ Controller

➤ Load 
Generator

➤ Data 
Processor

At least one 
of each

Controller has heavy load.

Load Generator has medium load.

Data Processor has medium load.

Can configure a host as a Controller + Load 
Generator, but this is not recommended practice 
because running Vusers consume a lot of 
resources. Running Vusers on the Controller 
host is only appropriate for load tests that have a 
very small number of Vusers.

Can configure a host as a Controller + Data 
Processor, but this is not recommended practice 
because the Data Processor consumes high 
amounts of CPU and resources when processing 
results. 

It is recommended to designate spare 
Controllers and load generators for fault-
tolerance and high availability purposes.

MI Listener At least one 
if you are 
monitoring 
over a 
firewall

Medium load.

Cannot exist on a machine running IIS or a 
machine that is running Vusers.

Monitor Over 
Firewall 
machine

At least one 
if you are 
monitoring 
over a 
firewall

Light load.

Standalone installation is required. 

SiteScope 
(optional)

One Light load.

Machine
Quantity 
within the 
system

Load Considerations
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Use the diagram and table to determine which machines to allocate for 
which load testing tasks.

For example, you can combine a number of components that have a light 
load on a single machine. Conversely, consider installing components with 
a heavy load on standalone machines.

System Component Requirements and Considerations

The Performance Center system includes several components. This section 
provides hardware and software requirements and pre-installation 
considerations for each of the following Performance Center components:

➤ “User Site Server” on page 23

➤ “Administration Site Server” on page 24

➤ “Utility Server” on page 25

➤ “File Server” on page 26

➤ “Performance Center Hosts” on page 27

➤ “Database Servers” on page 28

➤ “Standalone Load Generator” on page 29

➤ “Standalone VuGen” on page 29

➤ “Standalone Analysis” on page 30

➤ “MI Listener” on page 30

➤ “Monitor Over Firewall Machine” on page 31

➤ “ERP and CRM Mediator” on page 31

➤ “SiteScope Server” on page 31
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User Site Server
The following table lists the hardware and software installation 
requirements for the User Site Server:

Pre-installation Considerations

➤ Before you install the Performance Center User Site Server, you need to 
install Microsoft Internet Information Services (IIS).

➤ The Performance Center User Site Server installation includes Apache 
Tomcat. Before you install the User Site Server, make sure to remove any 
existing versions of Apache Tomcat from the User Site Server machine.

➤ If you are installing the User Site Server on a Windows Server 2003 SP1 
machine, download the Microsoft patch from the following location: 
http://support.microsoft.com/kb/898708. This patch addresses a known 
Microsoft issue, when running IIS 6.0 on a Windows Server 2003 machine.

Component Requirement

Computer/Processor Type: Intel Xeon (or equivalent)
Cores: 2 (Single CPU Dual-Core or Dual CPU Single-
Core)
Speed: 2 GHz per processor/core or higher

Operating System ➤ Windows 2000 SP4 Server/Advanced Server

➤ Windows 2003 32-Bit SE/EE (Standard Edition or 
Enterprise Edition) SP1, SP1+R2, SP2, or SP2+R2

Server Software Microsoft Internet Information Server (IIS) 
version 5.x or 6.x

Memory 2 GB of RAM

Swap Space Twice the total physical memory

Free Hard Disk Space 300 MB or more recommended

Browser for Viewing 
User Site 

Internet Explorer 6 or 7

Screen Resolution for 
Viewing User Site

1024*768 or 1280*1024 pixels

http://support.microsoft.com/kb/898708
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➤ McAfee VirusScan Enterprise 8.0 includes a buffer overflow protection 
module, which is incompatible with the User Site. You can either upgrade to 
McAfee VirusScan Enterprise 8.5i patch 4 or perform a workaround on 
version 8.0. For more information, see “Working with McAfee VirusScan 
Enterprise 8.0” on page 160.

Administration Site Server
The following table lists the hardware and software installation 
requirements for the Administration Site Server:

Pre-installation Considerations

➤ Before you install the Performance Center Administration Site Server, you 
need to install Microsoft Internet Information Services (IIS).

➤ If you are installing the Administration Site Server on a Windows Server 
2003 SP1 machine, download the Microsoft patch from the following 
location: http://support.microsoft.com/kb/898708. This patch addresses a 
known Microsoft issue, when running IIS 6.0 on a Windows Server 2003 
machine.

Component Requirement

Computer/Processor 2 GHz processor or higher

Operating System ➤ Windows 2000 SP4 Server/Advanced Server

➤ Windows 2003 32-Bit SE/EE (Standard Edition or 
Enterprise Edition) SP1, SP1+R2, SP2, or SP2+R2

Server Software Microsoft Internet Information Server (IIS) 
version 5.x or 6.x

Memory 2 GB of RAM

Swap Space Twice the total physical memory

Free Hard Disk Space 1 GB

Browser for Viewing 
Admin Site 

Internet Explorer 6 or 7

Screen Resolution for 
Viewing Admin Site

1024*768 or 1280*1024 pixels

http://support.microsoft.com/kb/898708
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Utility Server
The following table lists the hardware and software installation 
requirements for the Utility Server:

Pre-installation Considerations

➤ Before you install the Performance Center Utility Server, you need to install 
Microsoft Internet Information Services (IIS).

Component Requirement

Computer/Processor Type: Intel Xeon (or equivalent)
Cores: 2 (Single CPU Dual-Core or Dual CPU Single-
Core)
Speed: 2 GHz per processor/core or higher

Operating System ➤ Windows 2000 SP4 Server/Advanced Server

➤ Windows 2003 32-Bit SE/EE (Standard Edition or 
Enterprise Edition) SP1, SP1+R2, SP2, or SP2+R2

Server Software Microsoft Internet Information Server (IIS) 
version 5.x or 6.x

Memory 2 GB of RAM

Swap Space Twice the total physical memory

Free Hard Disk Space 1 GB
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File Server
The following table lists the hardware and software installation 
requirements for the File Server:

Pre-installation Considerations

➤ Before you install the Performance Center File Server, you need to install 
Microsoft Internet Information Services (IIS).

➤ Vuser scripts and load test results are saved on the File Server. Therefore, you 
should bear in mind that the more load testing you do, the more memory 
space you will require on the File Server.

➤ You can configure the Performance Center system to use a network drive as 
the File Server. For more information, see “Using a Network Drive as the File 
Server” on page 154.

Component Requirement

Computer/Processor 2 GHz processor or higher

Operating System ➤ Windows 2000 SP4 Server/Advanced Server 

➤ Windows 2003 32-Bit SE/EE (Standard Edition or 
Enterprise Edition) SP1, SP1+R2, SP2, or SP2+R2

Server Software Microsoft Internet Information Server (IIS) 
version 5.x or 6.x

Memory 1 GB of RAM

Swap Space Twice the total physical memory

Free Hard Disk Space 20 GB
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Performance Center Hosts
The following table lists the hardware and software installation 
requirements for the Performance Center hosts:

Pre-installation Considerations

➤ Before you install the Performance Center hosts, you need to install 
Microsoft Internet Information Services (IIS).

➤ If you are running Windows XP Service Pack 2 (SP2), the Windows Firewall 
should be turned off on all host machines on which the upload/download 
features are used. See “Windows XP Professional SP2 Configuration” on 
page 144. 

➤ You can install the Load Generator component on a UNIX platform to run 
Vusers. The UNIX Vusers interact with the Controller, installed on a 
Windows machine. For more information, see Part III, “UNIX Installation.”

Component Requirement

Computer/Processor 2 GHz or higher processor

Operating System ➤ Windows 2003 32-Bit SE/EE (Standard Edition or 
Enterprise Edition)SP1, SP1+R2, SP2, or SP2+R2

➤ Windows XP 32-Bit SP2 with Firewall disabled

➤ Load Generator only: Windows Vista

Server Software Microsoft Internet Information Server (IIS) 
version 5.x or 6.x

Memory For Controller: 1 GB

For Load Generator: Dependant on protocol type 
and system under test. For example, Web 
(HTTP/HTML) protocol generally requires 4 MB per 
non-multi-threaded Vuser and 512 KB per multi-
threaded Vuser.

Swap Space Twice the total physical memory

Free Hard Disk Space 1 GB
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Database Servers
Performance Center supports the following database servers:

➤ Oracle 9i or 10g on Windows or UNIX platforms. 

➤ SQL Server 2000 SP4 or 2005 SP2 on Windows only. For SQL Server 2005 SP2 
the Compatibility level must be defined as SQL Sever 2000 (80). For more 
information, see “Changing the Database Model Compatibility Level” on 
page 141.

Pre-installation Considerations

➤ If the Performance Center database is configured to work in Named Instance 
mode, see “Working with a Non-Default MS-SQL Instance Name” on 
page 135 for configuration instructions.

➤ If you are using an Oracle database, ensure that the character set defined on 
the Oracle clients corresponds with the character set defined on the Oracle 
server. For more information, see “Verifying the Oracle Character Set” on 
page 128.

Note:

➤ For information and recommendations about configuring Oracle 
databases, see “Oracle Configuration” on page 123.

➤ For information and recommendations about configuring MS-SQL 
databases, see “MS-SQL Configuration” on page 134.
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Standalone Load Generator
The following table lists the hardware and software installation 
requirements for the Standalone Load Generator installation: 

Pre-installation Considerations

You cannot install the Standalone Load Generator on the same machine as 
another Performance Center component.

Standalone VuGen
The following table lists the hardware and software installation 
requirements for the Standalone VuGen installation:

Component Requirement

Computer/Processor 1 GHz or higher (2.4 GHz recommended)

Operating System ➤ Windows 2003 32-Bit SE/EE (Standard Edition or 
Enterprise Edition) SP2 and R2

➤ Windows XP 32-Bit SP2 with Firewall disabled

➤ Windows Vista 32-Bit 

Memory Dependant on protocol type and system under test. 

For example, Web protocol generally requires 4 MB 
per non-multi-threaded Vuser and 512 KB per 
multi-threaded Vuser.

Free Hard Disk Space 1 GB

Browser IE 6.0 SP1 or higher

Component Requirement

Computer/Processor 1 GHz or higher (2.4 GHz recommended)

Operating System ➤ Windows 2003 32-Bit SE/EE (Standard Edition or 
Enterprise Edition) SP2 and R2

➤ Windows XP 32-Bit SP2 with Firewall disabled

Memory 512 MB (1 GB recommended)
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Pre-installation Considerations

You cannot install VuGen on the same machine as another Performance 
Center component.

Standalone Analysis
The following table lists the hardware and software installation 
requirements for the Standalone Analysis installation:

Pre-installation Considerations

You cannot install Analysis on the same machine as another Performance 
Center component.

MI Listener
The MI Listener cannot be installed on a machine running IIS or on a 
machine that is running Vusers. Therefore, the MI Listener cannot be 
installed on the same machine as a Performance Center host or server, 
because the hosts and servers all include IIS.

Free Hard Disk Space 1 GB

Browser IE 6.0 SP1 or higher

Component Requirement

Computer/Processor 1 GHz or higher (2.4 GHz recommended)

Operating System ➤ Windows 2003 32-Bit SE/EE (Standard Edition or 
Enterprise Edition) SP2 and R2

➤ Windows XP 32-Bit SP2 with Firewall disabled

Memory 512 MB (1 GB recommended)

Free Hard Disk Space 1 GB

Browser IE 6.0 SP1 or higher

Component Requirement
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Monitor Over Firewall Machine
If a Monitor over Firewall Machine is installed on a machine without any 
other Performance Center components, you need to configure the 
Performance Center agent service to run with a local user who has 
administrative privileges instead of a regular system user. 

To configure the Performance Center agent service:

 1 On the Monitor over Firewall machine, select Start > Run, type services.msc 
and press ENTER.

 2 Right-click Performance Center Agent Service and select Properties.

 3 In the Log On tab, under Log on as, select This account.

 4 Enter a user name and password for a local user with administrative 
privileges.

ERP and CRM Mediator

➤ The ERP and CRM Mediator must be installed on a machine that resides in 
the same LAN as the monitored ERP/CRM server, preferably on a dedicated 
machine. It is not recommended to install the Mediator on a Siebel or 
Oracle server that is involved in the load test.

➤ By default, the Mediator agent is installed to run as a process. It is 
recommended to configure the Mediator agent to run as a service. To 
configure the agent to run as a service, select Allow virtual users to run on 
this machine without user login in the User Login Settings window.

For more information about the ERP and CRM Mediator, refer to the section 
in the HP Performance Center User’s Guide that describes ERP/CRM 
Diagnostics.

SiteScope Server

➤ Refer to the HP SiteScope Deployment Guide for minimum requirements.

➤ There are two possible SiteScope installations—one for SiteScope monitoring 
the Performance Center servers, and another to monitor applications. When 
using a SiteScope monitor, you cannot use the same SiteScope instance for 
both of these installations.
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➤ Disk performance counters are disabled by default in standard Windows 
2000 installations. To monitor disk drives using the SiteScope Disk monitor 
on machines running Windows 2000, you must enable these disk counters. 
Run diskperf -y from the command line on each Windows 2000 machine for 
which you want to monitor disk space, then reboot the machine. Select the 
disk drives you want to monitor from the machine’s Resource Status tab.

Pre-installation Considerations: All Components

This section includes pre-installation considerations for all Performance 
Center components. 

➤ Before you begin installing, you should decide which machine is to be used 
for what purpose, so that you know which components to install on which 
machines.

➤ “Default Web Site” must be configured on the IIS machine. To check, right-
click the My Computer icon on the IIS machine, and click Manage. The 
Computer Management console opens. Expand the Services and 
Applications node, and check that “Default Web Site” is displayed in the 
Internet Information Services folder. If it is not, you should contact your 
system administrator or reinstall IIS.

➤ On all Performance Center hosts and servers using IIS 6.x, ensure that the 
following Web Service Extensions are allowed in IIS:

➤ Active Server Pages

➤ ASP.NET v2.0.50727

➤ Server Side Includes

On the User Site server, also ensure that that the following Web Service 
Extension is allowed:

➤ All Unknown ISAPI Extensions 

➤ Do not install Performance Center components on machines with existing 
LoadRunner installations. Doing so causes conflicts between the products.

➤ Hyper-Threading must be disabled. Performance Center does not support 
Intel Hyper-Threading technology. Hyper-Threading can be disabled in the 
BIOS.
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➤ Performance Center hosts and servers cannot be installed on machines 
running IBM Proventia Desktop 9.0. If it is running, end the service.

➤ Ensure that the operating system and the database with which you are 
working are both configured for the same language. If they are not 
configured for the same language, some texts displayed in Performance 
Center will be corrupted. For example, if you are working with German, 
ensure that you are working on a German operating system, and that the 
database is configured for German.

➤ During installation of Performance Center servers and hosts, a default 
Performance Center system user, IUSR_METRO, is created in the 
Administrators user group of the server/host machines. Ensure that there is 
no security system in place that will remove the system user from the 
Administrators group.

➤ IUSR_<machine_name> must exist on all Performance Center machines.

➤ IWAM_<machine_name> must exist on all Performance Center Web server 
machines, and belong to the Administrators or IIS Worker Process groups.

➤ Microsoft Windows Script Host should be version 5.6 or later. To verify the 
version number, navigate to the <Windows installation 
directory>Windows\system32 directory. Right-click wscript.exe and select 
Properties. In the Version tab, verify the file version number.

➤ On all Performance Center machines, the date separator in the date format 
must be a forward slash (“/”).
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Required Services

Before you install Performance Center, the following services must be 
running:

Machine Services

On all Performance 
Center servers and 
hosts

➤ IIS Admin Service (Microsoft Service) and its 
startup type should be defined as Automatic 
(except for MI Listener, which cannot have IIS 
installed on same machine)

➤ Workstation (except on host machines 
designated as Load Generators only)

➤ TCP/IP NetBIOS Helper (except on host 
machines designated as Load Generators only)

➤ IPSEC Services (for TCP/IP security)

➤ NTLM Security support provider

➤ Remote Procedure Call (RPC)

➤ Management Instrumentation (for Performance 
Center health check)

➤ Event Log (optional— used for debugging)

➤ COM+ services (Event System and System 
application)

➤ HTTP SSL (for SSL)

➤ System Event Notification (for COM+)

On User Site and 
Administration Site 
servers only

➤ IIS Admin Service (Microsoft Service) and its 
startup type should be defined as Automatic

➤ World Wide Web Publishing Service (Microsoft 
Service) and its startup type should be defined 
as Automatic

➤ Distributed Transaction Coordinator (MSDTC)

On all host machines ➤ Remote Registry Service (Windows Service) and 
its startup type should be defined as Automatic.
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Browser Configuration

Performance Center supports IE 6 or 7. To view the Performance Center User 
Site and Administration Site correctly in Microsoft Internet Explorer (IE), 
configure the browser on any machine that accesses the sites so that it can 
allow cookies and active scripting. Performance Center also requires your 
browser to be configured with pop-ups enabled.

Note: To view Performance Center using Windows XP or Windows 2003, 
you must lower your browser’s security settings or add the Performance 
Center Sites to the trusted sites zone.

To configure IE 6 and IE 7 for use with Performance Center:

 1 In IE, select Tools > Internet Options. The Internet Options dialog box 
opens.

 2 Select the Privacy tab, and move the slider to select the Medium privacy 
setting level.

 3 In the Security tab click Custom Level. In the Security Settings dialog box, 
select Scripting > Active scripting.

 4 In the General tab click Settings, and ensure the following: (These settings 
are slightly different depending on whether you are using IE 6 or IE 7)

➤ If you are using IE 6:

➤ In the Check for newer versions of stored pages section, Every visit to 
the page is selected.

➤ In the Temporary Internet files folder section, Amount of disk space to 
use is set to 100 MB or higher.

➤ If you are using IE 7:

➤ In the Check for newer versions of stored pages section, Every time I 
visited the web page is selected.

➤ In the Temporary Internet Files section, Disk space to use is set to 
100 MB or higher.
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 5 Click OK.

Note: Performance Center does not support tabbed browsing in IE 7.



Part II

Windows Installation
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2
Installing Performance Center on 
Windows

This chapter describes how to install Performance Center components on a 
Windows machine. 

This chapter includes:

 ➤  Performing the Installation on page 40

 ➤  Installing Additional Components on page 55

 ➤  Removing or Changing your Performance Center Installation on page 57

 ➤  Silent Installation of Performance Center on page 63
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Performing the Installation

Important: If you are upgrading to Performance Center 9.1 from an earlier 
version, refer to the instructions in Chapter 5, “Upgrading to Performance 
Center 9.10.”

Before you install Performance Center, review the pre-installation 
information, including the system requirements, described in Chapter 1, 
“Before You Install.” 

You use the Setup program on the Performance Center installation disk to 
install each Performance Center component. You can install each 
component on a different machine or you can install more than one on the 
same machine. If you install more than one component on the same 
machine, install them all in the same folder.

Notes and Limitations:

➤ To run the Performance Center installation, you must have full local 
administrative rights on the designated machine.

➤ You cannot use the UNC (Universal Naming Convention) path to run the 
installation. Therefore, if the Performance Center installation directory is 
located on a network drive, the network drive needs to be mapped before 
you can run the installation.

➤ You cannot install Performance Center using a Remote Desktop 
connection (RDP).

➤ Performance Center cannot be installed on the same machine as 
LoadRunner. Before installing Performance Center, ensure that you have 
removed any version of LoadRunner that may exist on your system. 
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To install Performance Center or an additional component:

 1 Launch the Performance Center installation.

For all versions of Windows other than Windows 2000 SP4:

➤ Insert the installation disk and run setup.exe (<installation disk root 
directory>\setup.exe). Continue the installation with step 2 on page 42.

For Windows 2000 SP4:

 a From the Windows Control Panel, open the Add/Remove Programs 
dialog box.

 b In the Add or Remove Programs dialog box, click Add New Programs.

 c Click CD or Floppy.

 d Insert the Performance Center installation disk and click Next. 

 e Use the Browse button to navigate to the following directory:

 f Click Finish and continue the installation with step 3 on page 44.

<installation disk root directory>\PC\EN\setup.exe 
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 2 Select the desired installation option.

The Performance Center Setup program begins and displays the installation 
menu page. 

From the installation menu page, select one of the following options: 

➤ Performance Center Servers. Provides the option to install the Utility 
Server, the User Site Server, the Administration Site Server, and the File 
Server. These are all required components of Performance Center that 
you can install separately or together.

To install the ERP and CRM Mediator, you also select this option. When 
you get to the Setup Type page, choose the custom setup option and then 
select the ERP and CRM Mediator to be installed (step 8 on page 50).
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➤ Performance Center Host. Installs the components needed for 
controlling tests, running Vusers to generate load, or analyzing data. The 
same installation is used for all types of hosts. After installation, you 
configure each host as a Controller, Load Generator, or Data Processor 
machine.

➤ Load Generator. Installs a standalone version of the load generator. 
Instead of installing a Performance Center Host and then configuring it 
as a load generator, you can install a standalone version of the load 
generator. The load generator installation is separate from the regular 
Performance Center installation. To install the load generator, click this 
option and follow the steps in the wizard. 

➤ Monitors Over Firewall. Installs the components needed for monitoring 
over a firewall. For more information, see Part VI, “Using Firewalls in 
Performance Center.”

➤ MI Listener. Installs the components needed on the MI Listener machine 
used when running Vusers over a firewall and monitoring over a firewall. 
For more information about working with firewalls, see Part VI, “Using 
Firewalls in Performance Center.”

➤ Additional Components. Opens the Additional Components folder 
located in the root folder of the installation disk. From this folder, you 
can install or run the following components:

➤ Citrix Agent

➤ COM+ Server Monitor Probe

➤ DB Migration

➤ Download Monitor Over Firewall

➤ HP Performance Validation SDK

➤ IDE Add-ins

➤ MQ Tester

➤ MSDE

➤ PC_Upgrade

➤ SAP Tools

➤ SiteScope
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➤ Standalone Applications

➤ Unlock Utility

For a description of each of these components see “Installing Additional 
Components” on page 55.

 3 If necessary, install prerequisite software.

Specific software (for example, .NET Framework 2.0) needs to be installed 
before you can install Performance Center. If the prerequisite software is not 
already installed on your computer, the following dialog box opens: 

Click OK and follow the on-screen instructions to install the listed software 
before continuing with the Performance Center installation. If you click 
Cancel, the installer will exit because Performance Center cannot be 
installed without the prerequisite software.

For a full list of the prerequisite software, see “Performance Center 
Prerequisite Software” on page 221.
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Important: Microsoft Internet Information Services (IIS) is required for 
Performance Center servers or hosts. The servers or hosts will not function 
properly if IIS has not been installed. After you have installed Performance 
Center, you can no longer install IIS. If you are installing other Performance 
Center components (not servers or hosts), IIS is not required. 

If IIS is not installed on your computer, the above dialog box lists IIS as one 
of the prerequisite programs.

➤ For Performance Center servers or hosts: Click Cancel to exit the 
Performance Center installation. Install IIS on your computer and then 
restart the Performance Center installation. 

➤ For other Performance Center components: Click OK. A message opens 
asking you if you want to continue with the Performance Center 
installation. Click Yes to continue.
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 4 Start the installation.

The Performance Center Setup Wizard opens, displaying the Welcome page 
for the relevant Performance Center component.

Click Next to proceed.
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 5 Review the License agreement.

If the terms of the license agreement are acceptable to you, select I Agree. 

Click Next to proceed.
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 6 Register the Performance Center Installation on your computer.

In the Customer Information page, enter your name and organization 
name. 

Click Next to proceed.

For all versions of Windows other than Windows 2000 SP4:

➤ If you selected to install the Performance Center Servers, continue with 
step 7 below.

➤ If you selected to install a Performance Center component other than the 
Performance Center servers, skip to step 9 on page 51.

For Windows 2000 SP4:

➤ Select Custom from the Setup Type page that opens and click Next. 
Continue the installation with step 8 on page 50. 
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 7 Select a setup type. (Only for installation of Performance Center Servers)

In the Setup Type page, select Complete or Custom as follows:

➤ Complete. Installs the Performance Center features that you selected 
from the installation menu page in step 2 on page 42.

➤ Custom. Install only the Performance Center features that you want to 
install. 

Click Next to proceed.

Next Step: 

➤ If you selected Complete, go to step 9 on page 51.

➤ If you selected Custom, continue below with step 8 on page 50.
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 8 Select features to install. (Only for Custom setup)

If you chose to perform a Custom installation of Performance Center, select 
the Performance Center features that you want to install. 

To select an installation option (for example, installing or excluding a 
feature), click the arrow next to the feature and select one of the following 
options from the menu that opens:

➤ Will be installed on local hard drive. The feature is installed on your hard 
drive. 

➤ Entire feature will be installed on local hard drive. For features that 
include a number of different components, this option installs all sub-
components of the feature on the local hard drive.

➤ Feature will be installed when required. The feature is not installed but 
there is an option to install it later. When you try access the feature later, 
you receive a message asking you if you want to install it.
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➤ Entire feature will be unavailable. The feature is not installed and cannot 
be accessed later.

Note: For more information about the different Performance Center 
components, see “Performance Center Components and Data Flow” on 
page 17.

Click Next to proceed.

 9 Select an installation folder.

Accept the proposed folder for the installation or browse to an alternate 
folder. 
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To check required and available disk space for each drive, click Disk Cost. 

Click OK to close the Disk Cost dialog box.

Click Next to proceed.
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 10 Start the installation process.

The wizard prompts you to confirm the installation.

Click Next to start the installation.

Important: As part of the installation process, Performance Center 
automatically creates a local system user with administrative privileges 
(IUSR_METRO) on all host and server machines. This system user can be 
changed after installation. For information about changing the system user, 
see the HP Performance Center Administrator’s Guide.
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 11 Complete the installation process.

When the installation is complete, a wizard page opens confirming 
successful installation.

At the same time the Performance Center Readme file opens, displaying 
information about the new features in Performance Center and any last-
minute limitations. You can access the Readme at any time by selecting 
Start > Programs > HP Performance Center > Readme.

Click Finish to close the installation wizard. 

On the Performance Center installation menu page, click Exit.

The Performance Center installation is now complete.

Important: After installing any Performance Center components on a 
Windows 2000 machine, you must restart the computer.
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Installing Additional Components

You can install additional components that provide advanced features for 
working with Performance Center. You install these components from the 
Additional Components folder, located in the root folder of the installation 
disk. The following components are available:

➤ Citrix Agent. Installs an optional component on the server machine which 
enhances VuGen’s capabilities in identifying Citrix client objects. To install 
the Citrix agent, run CitrixAgent.exe.

➤ COM+ Server Monitor Probe. Configures the server machine for Microsoft 
COM+ monitoring. To install the COM+ Probe, run Com_Plus_Probe.exe. 
For more information, see the HP Performance Center User’s Guide that 
describes Application Component monitoring.

➤ DB Migration. If you are upgrading your Performance Center system, use the 
Database Migration tool to make your databases compatible with HP 
Performance Center 9.10. For more information, see Chapter 5, “Upgrading 
to Performance Center 9.10.”

➤ Download Monitor Over Firewall. Used to monitor the servers that are 
located over a firewall. You can install the Monitor over Firewall component 
directly from the installation disk or you can make it available for download 
from the User Site Downloads page. 

To make the Monitor over Firewall component available for download, copy 
monitors_over_fw.exe from the <Performance Center installation 
disk>\Additional Components\Download Monitor Over Firewall directory 
and paste it in the File Server’s <installation directory>\LRFS\Downloads 
directory.

➤ HP Performance Validation SDK. Provides you with the tools to create a 
custom protocol to run load tests on a previously unsupported application. 
For more information, see the HP Performance Validation SDK Developer’s 
Guide.

➤ IDE Add-ins. Installs a component that enables you to create and run scripts, 
written in your standard development environment, in the application's 
native language. Select an add-in from the IDE Add-ins directory, and run 
the add-in’s executable file.

➤ MQ Tester. 
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➤ MSDE. Installs the MSDE Database which is used for storing Analysis result 
data. To install MSDE, run Setup.exe.

➤ PC_Upgrade. Use this utility during the upgrade process. For more 
information, see “Uninstalling Previous Versions of Performance Center” on 
page 104.

➤ SAP Tools. The following SAP tools are available:

➤ SAPGUI Spy. Helps examine the hierarchy of GUI Scripting objects on 
open windows of SAPGUI Client for Windows. To install the SAPGUI Spy 
component, copy the three files mscomctl.ocx, Msflxgrd.ocx, and 
msvbvm60.dll from the SAP_Tools\SapGuiSpy\System32VBdlls directory 
to your C:\WINNT\system32 directory, then register the files. To register 
each file, select Run from the Windows Start menu and type: 
regsvr32 <File name>. Run SapSpy.exe from the SAP_Tools directory.

➤ SAPGUI Verify Scripting. Helps you verify whether the SAPGUI Scripting 
API is enabled. To install the Verify Scripting component, run 
VerifyScripting.exe from the SAP_Tools directory.

➤ Verify RFC User. Determines whether the SAP user you have specified to 
connect to the SAP system has permissions to invoke the required RFC 
functions necessary for working with SAP Diagnostics. To install the 
Verify RFC User component, copy RFCFunctionsCollection.dll from the 
Verify RFC User directory to your local hard drive. Then register the file 
by selecting Run from the Windows Start menu and typing: regsvr32 
RFCFunctionsCollection.dll. In the Verify RFC User directory, load 
AddMTSDestinationsFolder.reg by double-clicking the file. Then run 
VerifyRFCUser.exe.

➤ SiteScope. Installs the SiteScope server used for monitoring the Performance 
Center servers. In order to reduce load on the Utility Server, it is recommend 
to install SiteScope on the same machine as the Controller or on a dedicated 
server.

Note: The path to the directory in which SiteScope is installed should not 
contain spaces and must end with a directory called SiteScope.
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➤ Standalone Applications. Enables you to install the full standalone versions 
of HP Virtual User Generator, HP LoadRunner Analysis and the load 
generator.

➤ Unlock Utility. Use this utility to restore Performance Center authentication 
when you experience problems logging on to Performance Center with the 
LDAP or SSO server authentication configuration. For more information, see 
the section that discusses server authentication in the HP Performance Center 
Administrator’s Guide.

Removing or Changing your Performance Center 
Installation

After you have installed Performance Center, you can add Performance 
Center components to your original installation, repair installation errors, 
or uninstall Performance Center from your machine.

Important: If you have more than one Performance Center component 
installed on your machine, you cannot remove individual components. 
Rather, you need to uninstall Performance Center completely and then re-
install the features that you want.

This section includes the following topics:

➤ “Adding Performance Center Components” on page 57

➤ “Repairing Performance Center Installation Errors” on page 61

➤ “Uninstalling Performance Center” on page 62

Adding Performance Center Components
If you have one or more Performance Center components installed on your 
machine, you can add Performance Center components to your original 
installation.
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To add components to your Performance Center installation:

 1 Insert the Performance Center installation disk into your disk drive.

 2 From the Windows Control Panel, open the Add/Remove Programs dialog 
box.

 3 Select HP Performance Center from the list of currently installed programs 
and click Change. 

The Performance Center Setup Wizard opens, displaying the Welcome page.

Click Next to proceed.
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 4 In the Maintenance Type page that opens, select Modify.

Click Next to proceed.
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 5 In the Custom Setup page, select the Performance Center components that 
you want to add to your installation as well as the components that are 
currently installed on your machine.

To select a component to be installed, click the arrow next to the 
component and select Will be installed on local hard drive. 

Important: You must ensure that all the Performance Center components 
that are currently installed on your machine are also selected for 
installation. If these components are not selected for installation, they may 
become corrupted.

For more information about the different Performance Center components 
that you can install, see “Performance Center Components and Data Flow” 
on page 17.
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Click Next to proceed and follow the instructions in the wizard to complete 
the process.

Repairing Performance Center Installation Errors
Use this option to repair errors in your original Performance Center 
installation. This option is used to fix missing or corrupt files, shortcuts and 
registry entries. You do not use this option to add or remove Performance 
Center components.

To repair your Performance Center installation:

 1 Insert the Performance Center installation disk into your disk drive.

 2 From the Windows Control Panel, open the Add/Remove Programs dialog 
box.

 3 Select HP Performance Center from the list of currently installed programs 
and click Change. The Performance Center Setup Wizard opens, displaying 
the Welcome page. 
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Click Next to proceed.

 4 In the Maintenance Type page that opens, select Repair. 

Click Next to proceed and follow the instructions in the wizard to complete 
the repair process.

Uninstalling Performance Center
Use this option to uninstall Performance Center and all its components 
from your machine.

To uninstall Performance Center:

 1 From the Windows Control Panel, open the Add/Remove Programs dialog 
box.

 2 Select HP Performance Center from the list of currently installed programs 
and click Remove. 

 3 Follow the instructions in the wizard to complete the uninstall process.
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Silent Installation of Performance Center

A silent installation is an installation that is performed automatically, 
without the need for user interaction. This section describes how to perform 
a silent installation of Performance Center.

Before you perform the installation, review the pre-installation information, 
including the system requirements, described in Chapter 1, “Before You 
Install.”

To perform a silent installation of Performance Center:

 1 Install the prerequisite software. For instructions, see “Prerequisite Software” 
on page 65.

You cannot proceed with the Performance Center installation until all the 
prerequisite software has been installed.

 2 After you have installed all the prerequisite software, install the relevant 
Performance Center components by running the following command from 
the command line:

where:

➤ <PC_Component> is the parameter name of the component you want to 
install. You can specify more than one component. 

➤ <Target_Installation_Directory> is the directory in which you want to 
install Performance Center.

Important: Components should be separated by commas. You always need 
to include the UpdateService component. 

For a list of the parameter names for each component, see “Component 
Parameter Names” on page 66.

msiexec /i <Installation_Disk_Root_Directory>\PC\MSI\HP_Performance_Center.msi 
ADDLOCAL=UpdateService,<PC_Component>
TARGETDIR="<Target_Installation_Directory>" /qnb
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For example, if you wanted to install the Performance Center Host to 
C:\Program Files\HP\Performance Center, you could run the following 
command:

Silent Installation of the Standalone Load Generator
This section describes how to perform a silent installation of the standalone 
load generator.

To perform a silent installation of the standalone load generator:

 1 Install all the prerequisite software except for IIS. For details, see 
“Prerequisite Software” on page 65. 

 2 Extract the Load Generator installation files to a local directory

 a From the <installation disk root directory>\Additional 
Components\Standalone Applications directory, run LoadGenerator.exe 
to open the Load Generator InstallShield Wizard.

 b In the Save files in folder box, enter the name of the local directory 
where you want to save the installation files.

 3 Run the following command from the command line:

where <Installation_Folder> is the local directory where you saved the 
installation files.

msiexec /i E:\PC\MSI\HP_Performance_Center.msi 
ADDLOCAL=UpdateService,Performance_Center_Host
TARGETDIR="C:\Program Files\HP\Performance Center" /qnb

msiexec /i "<Installation_Folder>\HP_LoadGenerator_91.msi" /qb
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 4 After you install the load generator, you need to install the Performance 
Center agent service and the Remote Management agent service.

 a To install the Performance Center agent service, run the following 
command from the command line:

 b To install the Remote Management agent service, run the following 
command from the command line:

Prerequisite Software
Install the following prerequisite software by running the relevant 
commands as described in the table below. 

Note: Do not install IIS if you are installing the standalone load generator or 
the MI Listener.

"<load_generator_installation_directory>\Load 
Generator\launch_service\bin\magentservice.exe" -install

"<load_generator_installation_directory>\Load 
Generator\al_agent\bin\alagentservice.exe" -install

Prerequisite Software Command 

.NET Framework 2.0 <Installation_Disk_Root_Directory>\PC\EN\prere
quisites\dotnet20\dotnetfx.exe /q:a /c:"install.exe 
/q"

Microsoft Data Access 
Components (MDAC) 2.8 SP1

<Installation_Disk_Root_Directory>\PC\EN\prere
quisites\mdac28\mdac28.exe /q:A /C:"setup 
/QNT"

Microsoft Core XML Services 
(MSXML) 6.0

msiexec /log c:\msxml.log /quiet  /I 
<Installation_Disk_Root_Directory>\PC\EN\prere
quisites\msxml6\msxml6.msi

Microsoft Visual C++ 2005 
Redistributable Package (x86)

<Installation_Disk_Root_Directory>\PC\EN\prere
quisites\vc2005redist\vcredist_x86.exe  /q:a
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Component Parameter Names
The following table describes which parameter to enter for each 
Performance Center component. For a description of each of these 
components, see “Performance Center Components and Data Flow” on 
page 17.

Microsoft Windows Installer 3.1 <Installation_Disk_Root_Directory>\PC\EN\prere
quisites\msi31\WindowsInstaller-KB893803-v2-
x86.exe /quiet

Web Services Enhancements 
(WSE) 3.0 for Microsoft .NET 
Redistributable Runtime MSI

msiexec /log c:\WSE3.log /quiet  /I 
<Installation_Disk_Root_Directory>\PC\EN\prere
quisites\wse30\MicrosoftWSE3.0Runtime.msi 
ALLUSERS=1

Web Services Enhancements 
(WSE) 2.0 SP3 for Microsoft 
.NET Redistributable Runtime 
MSI

msiexec /log c:\WSE2.log /qn /i 
<Installation_Disk_Root_Directory>\PC\EN\prere
quisites\wse20sp3\MicrosoftWSE2.0SP3Runtim
e.msi ALLUSERS=1

Internet Information Services 
(IIS)

(Not for standalone load 
generator or MI Listener)

For Windows 2000:

sc start W3SVC

C:\WINNT\Microsoft.NET\Framework\v2.0.5072
7\aspnet_regiis

For Windows 2003/XP:

Sysocmgr.exe /i:sysoc.inf /u:c:\temp\IIS6.txt /r /q

C:\WINDOWS\Microsoft.NET\Framework\v2.0.5
0727\aspnet_regiis

Component Parameter

Performance Center Host Performance_Center_Host

ERP and CRM Mediator ERP_and_CRM_Mediator

Prerequisite Software Command 



Chapter 2 • Installing Performance Center on Windows

67

Silent Uninstall of Performance Center
You can silently uninstall Performance Center by running the following 
command from the command line:

All Performance Center Servers Performance_Center_Servers

Note: This parameter is used to install all of 
the following Performance Center servers:

➤ User Site Server

➤ Administration Site Server

➤ Utility Server

➤ File Server

User Site Server User_Site_Server

Administration Site Server Administration_Site_Server

Utility server Utility_Server

File server File_Server

MI Listener Component MI_Listener_Component

Monitors over FireWall Monitors_over_FireWall

msiexec /uninstall 
“<Installation_Disk_Root_Directory>\PC\MSI\HP_Performance_Center.msi” /qnb

Component Parameter
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3 
Introducing the UNIX Installation

You can install the load generator component on a UNIX platform to run 
virtual users. The UNIX virtual users interact with the Controller 
component, installed on a Windows machine. 

This chapter discusses the installation steps and system requirements for 
installing the load generator on a UNIX platform. 

Note: The Controller is installed as part of the Performance Center host. For 
information about installing the Performance Center host, see Chapter 2, 
“Installing Performance Center on Windows.”

This chapter includes:

 ➤  UNIX Installation Steps on page 72

 ➤  Supported Platforms on page 73

 ➤  System Requirements on page 74

 ➤  Increasing Process Entries on page 76

 ➤  Increasing File Descriptors on page 78

 ➤  Increasing Swap Space on page 80
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UNIX Installation Steps

This section describes the installation of the load generator component on 
all of the supported UNIX platforms. When a section applies only to a 
specific platform, it is explicitly stated. 

The main steps of the installation process are:

➤ Installing the program files

➤ Setting the environment

For more information about how the load generator interacts with the other 
Performance Center components, see Chapter 1, “Before You Install.”

Setting the Environment
Since Performance Center Vusers emulate actual users of your system, the 
environment on the virtual user machine must be configured for the Vuser 
to run correctly. The environment variables are defined in the .cshrc file for 
cshell users, and in the .profile file for Bourne and kshell users.

➤ The installation process determines the platform on which the Vuser is 
running, and prepares a script to modify the .cshrc file for cshell users. 
Bourne and kshell users should modify the .profile file manually. See 
“Verifying Your UNIX Installation” on page 92, for sample .cshrc and 
.profile files.

➤ The installation process helps you set the environment variable to indicate 
the location of the Performance Center bin directory and any DLLs used by 
the underlying protocol. This environment variable is called LIBPATH on 
AIX, SHLIB_PATH on HP/UX, and LD_LIBRARY_PATH on Solaris and Linux.
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Supported Platforms

You can install a UNIX load generator on the following supported platforms: 

Performance Center supports all X Servers. 

Note: For Linux platforms, you should install the updated glibc packages 
that provide security and bug fixes. For more information, refer to 
https://rhn.redhat.com/errata/RHSA-2003-325.html#Red%20Hat%20Linux%208.0

HP-UX Required Patches

To run Performance Center on HP-UX platforms, you must first install two 
HP patches, PHSS_17225 and PHSS_17872, which upgrade the C++ libraries. 
These patches are also available on HP's site.

 1 Login as user root. 

 2 Copy PHSS_17225 and PHSS_17872 (from the patch directory of the LR 
installation) to the /tmp directory. 

 3 Run "sh PHSS_17225" – this creates two files: PHSS_17225.text and 
PHSS_17225.depot. 

 4 Run "swinstall -x matchtarget=true -s PHSS_17225.depot" 
After the patch installation, the system will be rebooted. 

 5 Run "sh PHSS_17872" – this creates two files: PHSS_17872.text and 
PHSS_17872.depot.

 6 Run "swinstall -x matchtarget=true -s PHSS_17872.depot" 

Platform Version

Solaris Solaris 9 (2.9) and 10 (2.10)

HP HP-UX 11.i V2

IBM AIX 5.2 and 5.3

Linux RedHat Linux Advanced Server 4.0 FP 5 
and 5.0
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System Requirements

The following table describes the system requirements for the UNIX load 
generator. The actual resources may vary, depending on your number of 
Vuser licenses. 

The resources for Vusers listed below apply to each Vuser. If you are 
installing multiple Vusers, calculate your requirements by multiplying the 
figures by the number of Vusers.

The Memory Space entries in the table above apply to a general C-Vuser 
type. Other types may require more memory space. For example, each Web 
Vuser uses at least 500 KB.

A load generator uses the following additional File Descriptor resources:

➤ 14 file descriptors for the Performance Center launch service

➤ 20 file descriptors for the Performance Center agent

➤ 30 file descriptors for each Vuser driver. By default, there is a driver for every 
50 Vusers.

Resource Type Requirement

Disk Space
required for program installation

22 MB (34MB for Linux)

Memory Space
each Vuser if run as thread

300 KB (at least). This amount may vary, 
depending on the operating system and 
platform, and does not include the 
memory used by the process

Memory Space
each Vuser if run as process

1.5 MB (2.5 MB for Solaris)

Swap Space Approximately 1:7 memory/swap ratio

Free Process Entries
each Vuser if run as process

1

File Descriptors
each Vuser if run as thread

2 (see below)
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For example, to compute the number of file descriptors used in running 100 
threaded Vusers the load generator requires:

➤ 14 for the Performance Center launch service

➤ 20 for the Performance Center agent

➤ 60 for 2 drivers (30 x 2, each one drives 50 Vusers)

➤ 200 for 100 Vusers (each Vuser requires 2)

Total: 294 File Descriptors

If Vusers are run as processes instead of threads, one driver is run per Vuser. 
Therefore, each Vuser requires 30 file descriptors.

You can increase the number of file descriptors, process entries, and the 
amount of swap space by configuring the kernel, as described in this 
chapter.

Note: Most operating systems using HP Performance Center 9.10 have 
sufficient default file descriptors, process entries and swap space, and rarely 
require reconfiguration.
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Increasing Process Entries 

Each Vuser requires several free process entries. To increase the number of 
process entries on your system, you need to reconfigure the kernel. 

Solaris
This section describes how to reconfigure the kernel for Solaris operating 
systems.

To reconfigure the kernel for Solaris operating systems:

 1 Locate the /etc/system file.

 2 Set the maximum number of processes in the system file. Type:

 3 Execute the touch/reconfigure command. Type:

 4 Reboot the machine. 

HP-UX
This section describes how to reconfigure the kernel for HP platforms.

To reconfigure the kernel for HP platforms:

 1 Log on as root user.

 2 Invoke the sam tool to reconfigure the kernel. Type:

 3 Select Kernel Configuration > Configurable Parameters. 

set max_nprocs=number (e.g.712)

touch /reconfigure

sam &
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 4 Set the following parameters to the desired values:

➤ nproc. The number of simultaneous processes—(# of Vusers * 2) + 200.

➤ maxuser. The number of maximum users—DB + RTE Vusers + 20.

➤ maxuprc. The number of processes per user—# of Vusers * 2.

 5 Reboot the machine.

IBM
This section describes how to reconfigure the kernel for IBM platforms using 
the AIX operating system.

To reconfigure the kernel for IBM platforms using the AIX operating 
system:

 1 Display the current settings. Type:

 2 Increase the maximum number of process entries per user. Type:

 3 Set the nproc and maxusers parameters to the desired values.

Linux
This section describes how to reconfigure the kernel for Linux platforms.

To reconfigure the kernel for Linux platforms:

 1 Locate the /etc/security/limits.conf file.

 2 Set the maximum number of processes in the limits file. Type:

 3 Reboot the machine.

lsattr -EHl sys0

chdev -l sys0 -a maxuprocs = number (e.g.500)

hard nproc 8192
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Increasing File Descriptors

Each Vuser requires between 6 (for non-GUI Vusers) and 27 (for GUI Vusers) 
file descriptor entries. The procedure for increasing the number of file 
descriptors varies between platforms and shells.

All Platforms
In these examples, the number of descriptors is increased to the maximum 
of 1024.

 1 For sh and ksh users, type:

 2 For csh users type:

Solaris
This section describes some alternate procedures to increase file descriptors 
on Solaris operating systems. In these examples, the number of descriptors is 
increased to the maximum of 1024.

 1 Use the adb command to increase file descriptors (all shells). Note that 400 
HEX is the equivalent of decimal 1024. In the following example, kernel is 
the name of the kernel file, that is, kernel/unix.

 2 You can also increase the maximum number of file processes by 
reconfiguring the kernel. 

Log on as root user and set the rlim_fd_max parameter inside the 
/etc/system file by typing:

ulimit -n 1024

limit descriptors 1024

adb -w -k /kernel/dev/mem
rlimits+28?W 400
rlimits+28/W 400

set rlim_fd_max=1024
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 3 Save the file and reconfigure the system by typing:

 4 After reconfiguring the system, reboot the machine.

HP-UX
This section describes how to increase file descriptors for HP platforms.

 1 Log on as root user.

 2 Invoke the sam tool to reconfigure the kernel. Type:

 3 Select Kernel Configuration > Configurable Parameters. 

 4 Set the maxfiles parameters to the desired values. This is the equivalent of 
file descriptors on Sun platforms. 

➤ maxfiles. The number of files open at a given time, typically set to 60. 
Change it to 500 -1024. 

 5 Reboot the machine.

Linux
This section describes some alternate procedures to increase file descriptors 
on Linux operating systems. In these examples, the number of descriptors is 
increased to the maximum of 8192. 

 1 Add the following line to the /etc/security/limits.conf file:

 2 Add the following line to the /etc/sysctl.comf file:

 3 Reboot the machine.

touch /reconfigure

sam &

hard nfile 8192

fs.file-max = 8192
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Increasing Swap Space

Each Vuser requires a swap space ranging from 200 KB to 4 MB. Before 
adding space to your system configuration, you should determine your 
paging requirements. For environments that run programs with very large 
memory requirements, it is recommended that the paging space should be 
four times the size of the physical memory. If you do not have enough 
paging space, certain processes may be terminated, and others will be 
unable to start.

Solaris
This section describes how to increase swap space for machines running 
Solaris.

 1 List the available paging areas. Type:

 2 Display the available swap space. Type: 

 3 Create a new paging file. Type:

For example, mkfile 50m /extra/page_1

 4 Add the page file to the existing configuration. Type:

 5 Enable all swap areas listed in the file system configuration. Type:

swap -l

swap -s

mkfile size  path 

/usr/etc/swapon -a /extra/page_1 0 102400

/usr/etc/swapon -a 
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IBM
This section describes how to increase swap space for machines running the 
AIX Operating System.

 1 List the available paging areas. Type:

 2 Display the available swap space. Type: 

 3 Create a new paging file, using a value one quarter the size of the actual file 
size. For example, to create 200 MB of paging space in the chemvg volume 
group, type:

 4 To increase the size of an existing paging file, type:

For example: chps -s 10 page_01 adds 40 MB to page_01).

 5 Add the page file to the existing configuration. Type:

For example, swapon /dev/paging_01

 6 Enable all swap areas listed in the file system configuration file 
/etc/swapspaces. Type:

lsps -a

swap -s

mkps -a -n -s 50 chemvg

chps -s number paging_file

swapon paging_area

swapon -a 
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4 
Installing HP Performance Center on 
UNIX

Performance Center is installed using the installation media provided with 
the Performance Center distribution package. The installation uses a Java 
Runtime Environment (JRE).

The following sections describe installing the Performance Center UNIX 
components from a UNIX CD-ROM device. If a UNIX machine with a 
CD-ROM device is not available, you can copy the UNIX components from 
the CD into a directory on your computer, and transfer them to a UNIX 
directory via ftp or an NFS mounting at a later stage.

This chapter includes:

 ➤  Checking your Environment on page 84

 ➤  Installing HP Performance Center on Multiple Platforms on page 84

 ➤  Running the Installation Program on page 85

 ➤  Preparing to Install from a CD-ROM (IBM only) on page 86

 ➤  Post UNIX Installation on page 88

 ➤  Verifying Your UNIX Installation on page 92

 ➤  Running the Uninstall Program on page 93
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Checking your Environment

➤ Verify that a CD-ROM device is attached to your local or remote machine. 

➤ Find out which device driver is available for use with this drive. The device 
driver is usually located in the /dev directory of the machine to which the 
drive is attached. Consult your system administrator for the name of your 
device. 

Installing HP Performance Center on Multiple Platforms

To run Performance Center on multiple UNIX platforms, you need to install 
a separate version of Performance Center, in a separate directory, for each 
platform. The installation directories must be accessible to all the platforms. 
At the end of installation, follow the instructions for modifying the 
environment variables (at the end of this chapter) to indicate the 
Performance Center installation directories.

For example, to install Performance Center on a site that has both Solaris 
and IBM machines, you could use the following directories:

➤ For HP Performance Center Solaris: /tools/HP/sol/performance_center

➤ For HP Performance Center IBM: /tools/HP/ibm/performance_center

If you intend to run multi-platform scenarios, both directories should be 
NFS mounted. The Solaris machine should access the IBM installation 
directory and vice versa.
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Running the Installation Program

Before you begin the installation program, ensure that the install script, 
install.sh, is on the installation disk. Most operating systems require you to 
mount the CD-ROM drive to a local directory. For information for mounting 
a CD-ROM on IBM, see “Preparing to Install from a CD-ROM (IBM only)” on 
page 86.

There are two installation modes, UI (or AWT) mode and console mode. 

➤ To run the installation in UI mode, make sure that the DISPLAY 
environment variable is properly configured.

➤ To run the installation in console mode, add the -console parameter to the 
command line. For example:

To run the Performance Center installation program (in UI mode):

Note: Before entering the command, ensure that you have set the 
environment display correctly using the setenv command.

 1 Type the following:

The installation program begins and displays the license agreement.

 2 Read the agreement, select the I accept option, and click Next. The 
Performance Center installation program begins and displays the 
installation location dialog box.

Choose the location where you want to install Performance Center. To select 
a different location, click Browse, choose a directory, and click OK.

Click Next.

 3 A read-only dialog box with your installation settings opens. 

install.sh -console

install.sh
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To select different installation settings, click Back. To begin installation, 
click Next. 

 4 At the end of the installation, a message appears about setting the 
Performance Center environment variables. The next step outlines this 
procedure. First complete the automatic installation by clicking Next. 

 5 The installation procedure displays the final screen.

Click Finish to exit the installation procedure.

 6 The installation process prepared a file called env.sh that contains 
environment variable definitions for your cshell environment. Open the 
.cshrc file for each Performance Center user and add the following 
statement:

where <../Performance_Center> is the path to the Performance Center 
installation directory.

Bourne shell and kshell users should refer to “Post UNIX Installation” on 
page 88 for instructions on modifying the .profile file.

 7 Bring up a new terminal to run the .cshrc file. For more information about 
.cshrc files, see “Post UNIX Installation” on page 88.

 8 Run verify_generator to verify your load generator installation. This is a 
confirmation step to ensure that the specified directory and device name are 
correct, and that you have sufficient disk space. For information about the 
tests performed by verify_generator, see “Verifying Your UNIX Installation” 
on page 92.

Preparing to Install from a CD-ROM (IBM only)

When installing Performance Center on an IBM platform, you must mount 
the CD-ROM drive to access the installation program.

To mount the CD-ROM drive:

 1 Insert the CD-ROM into the drive and log in or su as root user.

source <../Performance_Center>/env.sh
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 2 Create the Performance Center installation directory by typing:

 3 To add a CD-ROM file system, you need to use SMIT. To enter the program, 
type:

 4 From within SMIT, select File Systems.

 5 Select Add/Change/Show/Delete File Systems.

 6 Select CD ROM File Systems.

 7 Select Add a CDROM File System.

 8 Choose a DEVICE name. Note that device names for CD-ROM file systems 
must be unique.

 9 Type in the following MOUNT POINT:

 10 Select the Do command, or press Enter if you are using the ASCII interface.

 11 Quit the SMIT program.

 12 To mount the CD-ROM file system, type:

 13 For the FILE SYSTEM Name, select either /dev/cd0 or /dev/cd1.

 14 Select the mount directory:

 15 Select cdrfs to set the TYPE of file system.

 16 Select Yes to mount as a READ-ONLY system. 

 17 Select Do or Enter if you are using the ASCII interface.

 18 Close your connection as the root user.

mkdir -p /usr/cdrom/lrun

smit storage

/usr/cdrom/lrun

smit mountfs

/usr/cdrom/lrun
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Post UNIX Installation

After installing Performance Center, prior to starting work, you should 
check that your environment is configured properly. 

This section describes:

➤ Setting Environment Variables

➤ Checking Authorizations

➤ Sample .cshrc and .profile Files

After you complete the post-installation configurations, run the 
Performance Center verification utility to check your installation. For more 
information, see “Verifying Your UNIX Installation” on page 92.

Setting Environment Variables
The Performance Center installation procedure created a file, env.sh, which 
sets the environment variables. Instead of manually updating your .cshrc 
file with the variable definitions, you include a statement to access env.sh at 
the end of the .cshrc file. This section describes the environment variables in 
your env.sh file. If you are working with kshell or Bourne shell, you should 
manually set these variables in your .profile file. The syntax in the examples 
below are for cshell users. For kshell and Bourne shell users, see “HP 
Performance Center Settings in the .profile File” on page 91.

➤ M_LROOT. Set M_LROOT to the Performance Center installation directory. 
For example:

➤ PATH. The location of Performance Center’s executable programs, the bin 
directory, must be added to the PATH variable. 

➤ LD_LIBRARY_PATH. (Solaris, Linux), LIBPATH (AIX), SHLIB_PATH (HP-UX)

setenv M_LROOT /tools/lrunner

set path = ($path $M_LROOT/bin)
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The path should include the location of Performance Center’s dynamic 
libraries ($M_LROOT/bin). To set the path, type: 

Check the dynamic libraries used by your application, and make sure that 
their path is also included in the appropriate dynamic library path 
environment variable (LD_LIBRARY_PATH, SHLIB_PATH or LIBPATH).

To check the dynamic libraries used by your application, type:

Note: To use Oracle73, you need to add the path Oracle73 libraries to the 
dynamic libraries path environment variable.

Checking Authorizations
To execute Vusers on remote hosts, you must be authorized to execute a 
remote shell.

➤ To check your permissions on a Solaris, Linux, or IBM host, type:

➤ To check your permissions on an HP host, type: 

If you do not have permission, consult the .rhosts file (man rsh or remsh).

setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:$M_LROOT/bin /*Solaris and 
Linux*/
setenv SHLIB_PATH ${SHLIB_PATH}:$M_LROOT/bin/*HP Platforms */
setenv LIBPATH “${LIBPATH}:$M_LROOT/bin” /*IBM Platforms */

ldd my_application  /* Sun and Linux platforms */
chatr my_application  /* HP platforms */
dump -H my_application  /* IBM platforms */

rsh hostname ls

remsh hostname ls
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Sample .cshrc and .profile Files
This section includes examples of Performance Center settings within a 
user’s .cshrc file and .profile file.

Performance Center Settings in the .cshrc File

The following is an example of Performance Center settings within a user’s 
.cshrc file:

# HP Performance Center settings #
#Chooses a path based on the location of the machine dependent HP Performance 
Center installation

switch ("`uname`")
case SunOS:

setenv M_LROOT {replace with HP Performance Center Solaris
installation path}
setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:${M_LROOT}/bin

breaksw

    case HP-UX:
setenv M_LROOT {replace with HP Performance Center HP-UX

installation path}
setenv SHLIB_PATH ${M_LROOT}/bin ${SHLIB_PATH}

breaksw

case Linux:
setenv M_LROOT {replace with HP Performance Center SunOs

installation path}
    setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:${M_LROOT}/bin
breaksw

case AIX:
 setenv M_LROOT {replace with HP Performance Center AIX

installation path}
setenv LIBPATH ${M_LROOT}/bin:${LIBPATH}

breaksw
endsw

set path = ($M_LROOT/bin $path)

# End HP Performance Center setting #
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HP Performance Center Settings in the .profile File

The following is an example of Performance Center settings within a user’s 
.profile file for kshell and Bourne shell environments:

# HP Performance Center settings #
#Chooses a path based on the location of the machine dependent HP Performance 
Center installation

case "`uname`" in
SunOS)
 M_LROOT={replace w/ PC Solaris installation path} ; export M_LROOT
   LD_LIBRARY_PATH=${M_LROOT}/bin ; export LD_LIBRARY_PATH
;;

HP-UX)
    M_LROOT={replace w/ PC HP-UX installation path} ; export M_LROOT
    SHLIB_PATH={${M_LROOT}/bin ; export SHLIB_PATH
;;

AIX)
    M_LROOT={replace w/ PC AIX installation path} ; export M_LROOT
    LIBPATH=${M_LROOT}/bin ; export LIBPATH
;;

Linux)
    M_LROOT={replace w/ PC Linux installation path} ; export M_LROOT
    LD_LIBRARY_PATH=${M_LROOT}/bin; export LD_LIBRARY_PATH

esac

PATH=${M_LROOT}/bin:${PATH}; export PATH

# End HP Performance Center settings #
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Verifying Your UNIX Installation

Performance Center has a setup verification utility, verify_generator, that 
checks the Performance Center setup. It checks environment variables and 
your .cshrc file to verify that they are set up correctly. The verify_generator 
utility checks the remote Vuser hosts. 

It is strongly recommended that you run verify_generator after a Vuser 
installation, before attempting to invoke Performance Center. 

The verify_generator Test
The utility checks the following items in the Vuser environment: 

➤ There are at least 128 file descriptors

➤ The .rhost permissions have been defined properly: -rw-r--r--

➤ The host can be contacted by using rsh to the host. If not, it checks for the 
host name in .rhosts

➤ M_LROOT is defined

➤ .cshrc defines the correct M_LROOT

➤ .cshrc exists in the home directory

➤ The current user is the owner of the .cshrc

➤ A Performance Center installation exists in $M_LROOT

➤ The executables have executable permissions

➤ PATH contains $M_LROOT/bin, and /usr/bin

➤ The rstatd daemon exists and is running
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Running verify_generator
The syntax of verify_generator is as follows:

verify_generator [-v]

Options:

-v

Provides detailed information about the checks.

If the settings are correct, verify_generator returns ‘OK’. If they are 
incorrect, verify_generator returns ‘Failed’ and a suggestion on how to 
correct the setup.

Running the Uninstall Program

The Performance Center uninstall program, like the installation program, 
uses a Java Runtime Environment (JRE). You can also run the uninstall 
program in UI mode or in console mode.

When running the uninstall program in console mode, add the console 
parameter to the end of the command line.

To run the uninstall program:

 1 Ensure that the following processes are not running on your machine:

➤ m_agent_daemon

➤ al_agent_daemon

 2 To access the program, type:

 3 Type:

cd <installation directory>/_uninst

./uninstall -console



Chapter 4 • Installing HP Performance Center on UNIX

94



Part IV

Upgrade



96



97

5 
Upgrading to Performance Center 9.10

This chapter explains how to upgrade your system to HP Performance 
Center 9.10. Before performing the upgrade, make sure you understand all 
the procedures involved in the upgrade process.

This chapter includes:

 ➤  The Upgrade Process: Basic Steps on page 98

 ➤  Backing Up Data on page 100

 ➤  Uninstalling Previous Versions of Performance Center on page 104

 ➤  Cleaning Performance Center Machines on page 104

 ➤  Installing Performance Center 9.10 on page 107

 ➤  Performing File Migration on page 107

 ➤  Performing Database Migration on page 107

 ➤  Configuring Performance Center on page 112

 ➤  Setting the License Keys on page 112

Note: To enable upgrading to Performance Center 9.10 with the minimum 
possible interruption to your system operation, you should give HP 
Customer Support advance notice of your upgrade dates, and have your 
system/network/security/database administrators assist you during the 
upgrade process. 



Chapter 5 • Upgrading to Performance Center 9.10

98

The Upgrade Process: Basic Steps

This section provides a general outline of the steps that you need to carry 
out to upgrade to HP Performance Center 9.10. Review these steps before 
you begin the upgrade process. 

Back Up Data (hosts, file servers, 
databases, and license keys)

Uninstall Current Version of 
Performance Center

Install New Version of Performance 
Center

Perform File Migration

Perform Database Migration

Reconfigure the Administration Site

Set License Keys

Clean Machines
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To upgrade your current version of Performance Center to version 9.10:

 1 Back up the relevant data.

➤ If you need to upgrade the host machine’s operating system to a 
supported operating system, you should back up the Temp and 
orchidtmp directories on each host machine. For more information, see 
“Host Data Backup” on page 100.

➤ Back up the user data folders on the Performance Center File Server. For 
more information, see “File Server Backup” on page 101.

➤ Back up the database to protect the data in case of a migration error. For 
more information, see “MI_LRDB Database Backup” on page 102.

➤ Save your license key details. For more information, see “License Key 
Backup” on page 103.

 2 Uninstall the current version of Performance Center.

For details, see “Uninstalling Previous Versions of Performance Center” on 
page 104.

 3 Install all of the Performance Center 9.10 components, including servers 
and hosts. 

Before you install Performance Center, review the pre-installation 
information, including the system requirements, described in Chapter 1, 
“Before You Install.”

 4 If you backed up the host data, restore the orchidtmp and temp folders. 

For details, see “Performing File Migration” on page 107.

 5 Perform database migration.

Use the Performance Center DB Migration tool to make your databases 
compatible with HP Performance Center 9.10. For details, see “Performing 
Database Migration” on page 107.

 6 Reconfigure the system in the Performance Center Administration Site.

For details, see “Configuring Performance Center” on page 112.
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Backing Up Data

Before performing database migration and uninstalling previous versions of 
Performance Center, you should back up the host data, File Server data, 
MI_LRDB databases, and the Performance Center and host license keys.

Host Data Backup
If you are installing a new image or upgrading the host machine’s operating 
system to a supported operating system, you should back up the Temp and 
orchidtmp directories on each host machine. To locate a machine’s Temp 
directory, open Windows Explorer, type %temp% in the Address bar, and 
press ENTER. To locate the orchidtmp directory, navigate to <Performance 
Center directory>\orchidtmp.

To avoid data loss from test runs that have not yet been collated or analyzed:

➤ Collate and analyze results from the load test runs on the User Site

➤ Delete all unnecessary runs

Note: For a list of supported operating systems, see “System Component 
Requirements and Considerations” on page 22.
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File Server Backup

You should back up the user data folders on the Performance Center File 
Server.

 1 On the File Server machine, open the <Performance Center directory>\LRFS 
directory.

 2 Make a backup copy of the numbered folders in the LRFS directory. For 
example: 1, 2, 3, 4.

 3 If you published load tests to the Dashboard, you should also make a backup 
copy of the DashboardGraphs folder.



Chapter 5 • Upgrading to Performance Center 9.10

102

MI_LRDB Database Backup
Before performing database migration, you should create a database backup 
to protect your data in case of migration error. You can recover the data by 
restoring the backed up database. 

➤ For details about restoring an Oracle database, see “Restoring Oracle 
Database Backup” on page 131.

➤ For details about restoring an MS-SQL database, see “Restoring MS-SQL 
Database Backup” on page 140.

Note: Make sure that the database backup is synchronized with your file 
system backup.

Before Backing Up

Before you back up your database, check the following:

➤ Ensure that there are no tests in the following states: Ready, Collating 
Results, Running, Stopping, Creating Analysis Data, Deleting Temporary 
Results. 

You can check the state of test runs in the Performance Center 
Administration Site from the Test Runs page (Site Management > Test Runs), 
or by running the following query: 

In cases where there are such runs, make sure that the operation currently 
running finishes before executing the migration.

➤ Ensure that all host machines configured in the Administration Site, 
actually exist. If a host does not exist, is turned off, or does not have a 
network connection, you must delete it from the Administration Site 
resources to prevent configuration problems later on.

SELECT * FROM SessionRuns WHERE State in (1,2,3,7,8,13)
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Backing Up Your Database

The sections describes how to back up the MI_LRDB database.

To back up the MI_LRDB database on a Microsoft SQL server:

 1 Launch Microsoft SQL Server > Enterprise Manager.

 2 Select the SQL Server that contains the MI_LRDB database.

 3 Click the Databases tab, and select MI_LRDB as the database.

 4 Right-click MI_LRDB > Select All Tasks > Backup Database, and specify the 
destination of the backup.

To back up the MI_LRDB database on an Oracle database server: 

 1 Open a command window from a computer with an Oracle client.

 2 To connect to and back up the MI_LRDB database, type:

For example:

License Key Backup

After you migrate your database, all license information will be deleted from 
the Performance Center system and you will have to configure the license 
keys again. To use the same license keys in the migrated system, save the 
Performance Center and host license keys.

To save the license keys:

 1 From the Performance Center Administration Site left menu, select System 
Configuration > License. 

 2 Copy the License Key strings displayed under Performance Center License 
and Host License.

exp system/<password>@<server-name> 
owner=MI_LRDB file=<file-name>.dmp

exp system/manager@amstel.HP.co.il 
owner=MI_LRDB file=D:\backups\MI_LRDB.dmp
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You will need this information when you reconfigure the Performance 
Center system settings in “Configuring Performance Center” on page 112.

Uninstalling Previous Versions of Performance Center

After backing up the relevant data, you need to uninstall earlier versions of 
Performance Center.

To uninstall Performance Center:

 1 From the Windows Control Panel, open the Add/Remove Programs dialog 
box.

 2 Select HP Performance Center from the list of currently installed programs 
and click Remove. 

 3 Follow the instructions in the wizard to complete the uninstall process.

 4 Reboot the machine.

Cleaning Performance Center Machines

After you have uninstalled earlier versions of Performance Center, you need 
to clean the Performance Center machines before you can install the current 
version.

To clean Performance Center machines:

 1 Run PC_Upgrade.exe:

 a On each machine, copy the <PC installation disk>\Additional 
Components\PC_Upgrade\PC_Upgrade.exe file to a local directory.

 b On all host and server machines, run the following command from the 
command line:

<local path>\PC_Upgrade.exe
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 c On all server machines, run the following command from the command 
line:

 2 Ensure that you have backed up the relevant Performance Center 
sub-directories.

➤ On all machines, ensure that you have backed up the <Performance 
Center directory>\orchidtmp directory. If you back up this directory, you 
maintain the capability to collate results that were not collated.

➤ On the File Server machine, ensure that you have backed up the 
<Performance Center directory>\LRFS directory.

 3 Delete the Performance Center directory on all machines.

 4 Ensure that the virtual directories on the relevant Performance Center 
machines have been removed. If they have not been removed automatically, 
delete them manually. 

➤ On the User Site machine, in IIS, delete the Loadtest virtual directory, 
located under Default Web Site.

➤ On the Administration Site machine, in IIS, delete the Admin virtual 
directory, located under Default Web Site.

➤ If you are uninstalling Performance Center 9.0: On all Performance 
Center machines, in IIS, delete the PCWSApplicationPool virtual 
directory, located under Application Pools.

 5 Delete the IUSR_METRO key from the crypto directory. Delete the files 
starting with f9416f003254e6f10da1fbad8e4c383_ from C:\Documents and 
Settings\All Users\Application Data\Microsoft\Crypto\RSA\MachineKeys

 6 Delete cookies and temporary internet files from your browser to avoid UI 
problems (Tools > Internet Options > General tab).

 7 If you are uninstalling Performance Center 8.1 SP4 and earlier: Remove the 
Performance Center folder from the Start menu. To do this, right-click Start 
and select Explore All Users. The Start Menu folder opens. Double-click the 
Programs folder, and delete the Performance Center folder. 

<local path>\PC_Upgrade.exe TestCenter
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 8 If you are uninstalling Performance Center 8.1: Clean environment 
variables.

➤ On all Performance Center machines: From the path system variable, 
delete the following paths: (These are paths that include the old 
Performance Center installation folder.)

➤ <Old PC Installation folder>\java\J-INTE~1\com\bin

➤ <Old PC Installation folder>\DbSetup

➤ <Old PC Installation folder>\bin

Note: Some of the above paths may not exist on all of the Performance 
Center machines.

To edit the path system variable, right-click My Computer and select 
Properties. In the Advanced tab, click Environment Variables to open the 
Environment Variables dialog box. In the System Variables area, select 
the Path variable and click Edit.

➤ On the User Site Server only: Delete the following Environment 
variables:

➤ CATALINA_HOME

➤ CLASSPATH

➤ JAVA_HOME

➤ JINTEGRA_HOME

 9 Reboot all Performance Center machines.
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Installing Performance Center 9.10

Install all of the Performance Center 9.10 components, including servers 
and hosts.

Before you install Performance Center, review the pre-installation 
information, including the system requirements, described in Chapter 1, 
“Before You Install.”

Performing File Migration

If you backed up the host data (see “Host Data Backup” on page 100), you 
need to restore the orchidtmp and temp folders. To restore these folders, 
copy orchidtmp to the new installation directory (for example, C:\Program 
Files\HP\Performance Center\orchidtmp), and copy the Vuser temp directory 
to its original location on the host machines.

If you backed up project data folders on the Performance Center File Server 
(see “File Server Backup” on page 101), copy the project data folders to the 
File Server directory.

Performing Database Migration 

Use the Performance Center Database Migration tool to make your 
databases compatible with HP Performance Center 9.10.

Note: Performance Center 9.10 supports data upgrades from Performance 
Center 7.8 SP4 and later.
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Before Migrating an MS-SQL Database
Before performing database migration on a Microsoft SQL server, use the 
SQL Server Enterprise Manager to ensure the following:

➤ All tables in the database must have DBO set as owner. If DBO is not set as 
the owner, run the following query for each relevant table:

➤ The user OrchidUser must exist in the User section of the MI_LRDB database. 
The user should have the login name OrchidUser with the db_owner 
permissions.

If there is a conflict between the OrchidUser identity that exists in the 
MI_LRDB scheme and the OrchidUser identity that exists in the server 
security logins, run the following query to synchronize OrchidUser:

Before Migrating an Oracle Database
Performance Center 9.10 supports Oracle 9.i or 10g on Windows and UNIX. 
If you are using an older unsupported version of Oracle, you need to 
upgrade your database to a supported version before performing database 
migration. For details, see “Upgrading Oracle to a Supported Version” on 
page 132.

Migrating Your Database
Follow the instructions in this section to migrate your database.

To migrate your database:

 1 Copy the DB Migration folder from the Performance Center installation disk 
(<PC installation disk>/Additional Components/DB Migration) to a local 
directory on the Administration Site sever. 

sp_changeObjectOwner 'table name' 'dbo'

sp_change_users_login 'Update_One', 'OrchidUser', 'OrchidUser'
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 2 Run DBMigration91.exe from the local directory. The Performance Center 
9.10 Database Migration tool opens.

 3 Select the check box to confirm that you have backed up your database.

 4 In the DB Server Type box, select the database type. 
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 5 In the DB Server Name box, the information you enter depends on the type 
of database:

➤ For an Oracle database: Enter the service name defined in your 
tnsnames.ora file.

➤ For an MS-SQL database: If you are working with the default instance 
name, enter the server name. If you are working with a non-default 
instance name, enter the DB host name in one of the following ways: 

or  

 6 If you are working with Oracle, Performance Center uses the default 
Performance Center database user name (MI_LRDB) and password. If you are 
working with SQL, enter the user name and password of a Performance 
Center database user with administrative privileges.

 7 Click Connect to verify that you can connect to the database.

➤ If connection to the database is successful, you receive a message in the 
Log area confirming the database connection details. 

➤ If connection to the database fails, you receive a message in the Log area 
providing possible reasons for the failure. In this case, verify that the 
username and password you provided are correct and that your database 
is up and running. 

 8 After you have established a database connection, click Migrate to start 
database migration. Upon completion, a message is displayed indicating 
whether database migration was successful. 

<server name>, <instance port>

<server name>\<instance name>
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Note: When you migrate your database, Vuser Scheduling is automatically 
enabled. This improves load test performance because Vusers are validated 
before the load test and Performance Center does not need to validate the 
Vusers during the run.

If Vuser Scheduling was disabled before you migrated the database, it is now 
enabled and as a result, the number of Vusers for all your future timeslots 
are set to zero. In such a case, go to the User Site Timeslots page 
(Project > Timeslots) and update the number of Vusers for future timeslots. 
Scheduled Autostart tests will not run until you update the relevant 
timeslots.

If you experience problems with the Database migration process, check the 
DB Migration log files for any errors or relevant messages. The DB Migration 
log file, DBMigration.log, is located in the Temp directory for the current 
user (%Temp%).

If you encounter an error during the migration process, you can restore the 
database backup files.

➤ For instructions about restoring Oracle databases, see “Restoring Oracle 
Database Backup” on page 131.

➤ For instructions about restoring MS-SQL databases, see “Restoring MS-
SQL Database Backup” on page 140.
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Configuring Performance Center

When you migrate your database using the Database Migration tool, all 
server information is deleted from the Performance Center system. After you 
perform database migration, you must reconfigure the system in the 
Administration Site (even if this is on the same machine, and all 
configuration settings are the same).

For details about configuring the Performance Center system, see “Initial 
System Configuration” on page 115.

Important: If you are using HP Diagnostics with Performance Center, after 
database migration you need to update the user name and password of the 
Diagnostics servers in the Performance Center Administration Site. 

To do this, on the Performance Center Administration Site left menu, select 
System Configuration > Diagnostics. Under Setting J2EE/.NET Environment, 
select the relevant server, click Edit, and enter the relevant user name and 
password.

Setting the License Keys

After you migrate your database, all license information is deleted from the 
Performance Center system and you need to re-enter your Performance 
Center license keys that you saved earlier (See “License Key Backup” on 
page 103).

For details about setting the license keys, see “Setting Your License Keys” on 
page 120.
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6
Required Configuration

This chapter describes the initial configration steps you need to complete 
before you begin working with Performance Center.

This chapter includes:

 ➤  Introducing the Post Installation Process on page 115

 ➤  Initial System Configuration on page 115

 ➤  Setting Your License Keys on page 120

Introducing the Post Installation Process

To complete the setup process after installing HP Performance Center, you 
must:

➤ Supply System Configuration information

➤ Set your license key

You perform these tasks from the Performance Center Administration Site. 

Initial System Configuration

To configure your Performance Center system, ensure that the default 
Performance Center system user, IUSR_METRO (created during installation), 
exists in the Administrators user group of the server/host machines. 
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To configure the Performance Center system:

 1 Log on to the Performance Center Administration Site by entering the 
following URL in your Web browser:

where server_name is the name or IP address of the HP Performance Center 
Administration Site Server.

 2 Because this is the first time you are logging on the system, you are 
redirected to the System Configuration page to provide database and file 
server information.

 a In the Database area, enter the following details about your database:

➤ DB host. The machine on which the database resides.

If the Performance Center database is an MS-SQL database with a non-
default instance name, enter the DB host name in one of the 
following ways: 

or  

http://<server_name>/admin 

<server name>, <instance port>

<server name>\<instance name>
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➤ DB type. The type of database installed on the server—either 
SQLServer or Oracle.

➤ DB instance (Oracle only). If you are using Oracle, in the DB instance 
box that opens, enter the service name defined in your tnsnames.ora 
file.

➤ OS (Oracle only). If you are using Oracle, select the operating system.

➤ User. The user name to connect to the database.

➤ Password. The password to connect to the database.

 b In the File Server area, in the Name box, enter the name of the machine 
that contains the File Server installation where system files such as scripts 
are stored. 

 c After you supply the necessary information, click Save.

 3 If Performance Center detects an existing database, a message is displayed 
asking you if you want to use the existing database as part of your 
configuration. Click Continue to use the existing database.

A log listing details of the system configuration process is displayed in the 
lower-left corner of the page. 

If the configuration is successful, click the Log to Site button. The 
Performance Center Administration Site Login page opens. 

If the configuration is not successful, the log provides a detailed message to 
help you correct the problem. After correcting the problem, repeat the save 
process. 

 4 If you are upgrading Performance Center to a new version, remove hosts 
that are not operational, do not exist, or may interfere with other 
environments. For example, if you are using your upgraded database in a 
staging environment, you may want to remove hosts that are currently 
being used in your production environment.

To remove hosts from the database:

 a In the database, set the status of the system as configured by running the 
following database query:

"UPDATE GLOBALDATA SET ENTRYVALUE='1' WHERE 
ENTRYNAME='SystemWasConfigured'"
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 b Log on to the Administration Site with a user that has Performance 
Center administration privileges, go to the Hosts page 
(Resources > Hosts), and delete all hosts that are no longer relevant.

 c Log off the Administration Site.

 d In the database, set the status of the system as not configured by running 
the following database query:

 5 Log on to the Administration Site with a user that has Performance Center 
administration privileges. 

If this is the first time you are logging on to Performance Center, use the 
default user name Admin and the default password Admin. After you have 
logged on, you will be able to modify your user name and password for the 
future.

Performance Center redirects you to the Server Configuration page.
 

"UPDATE GLOBALDATA SET ENTRYVALUE='0' WHERE 
ENTRYNAME='SystemWasConfigured'"
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The Database information and File Server name are supplied during the 
product installation and are displayed as read-only. 

You can click Test Connection to test the connection to the database.

Important: For all servers that you specify in the following steps, it is 
recommended to provide the name of the machine, rather than the IP 
address.

 6 In the Utility Server box, enter the name of the Utility Server machine.

 7 In the User Site Servers section, in the first Name box, enter the name of the 
User Site server machine. 

If you want to balance the load on your Performance Center system, you 
can enter the name of additional User Site servers in the remaining Name 
boxes.

 8 If you want use SiteScope to monitor your Performance Center resources, 
enter the relevant values for the SiteScope server.

➤ SiteScope Server. Enter the name of the SiteScope server.

➤ SiteScope Port. Enter the SiteScope port (default:8888).

➤ Use HTTPs. Select this option to use a Secure HTTP connection.

➤ Use Account. By default, Performance Center connects to SiteScope using 
the default SiteScope Administrator user. If the default SiteScope 
Administrator password was changed, or if you want to connect using a 
different SiteScope user, select this option. Enter the account name, and 
the user name and password defined to log in to the relevant SiteScope 
account. 

Note: The SiteScope administrator account name is administrator. For 
details about how to identify other SiteScope account names, see 
“Identifying the SiteScope Account Name” on page 149.
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 9 Click Save to save the server configuration settings.

Performance Center logs you out of the system.

Setting Your License Keys

When you purchase HP Performance Center, you receive two license keys.

➤ The Performance Center License enables you to use the product and run 
load tests. This license determines the number of load tests that you can 
run concurrently and the total number of Vusers available for use in all 
load tests.

➤ The Host License defines the Vuser protocols, monitors, and modules 
that are available on each host machine. This license also determines the 
number of Vusers available per protocol.

Enter the license key information as described below:

To update your Performance Center license key:

 1 On the Performance Center Administation Site left menu, select System 
Configuration > License. The License page opens.

 2 Under Performance Center License, click Set New License. The Set License 
dialog box opens. 

 3 Type the new Performance Center license key.

 4 Click OK to set the new license key. Performance Center checks the validity 
of the license key and closes the dialog box.
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To verify that the set license action was successful, refer to the log at the 
bottom of the page.

To update the host license key:

 1 On the Performance Center Administation Site left menu, select System 
Configuration > License. The License page opens.

 2 Under Host License, click Set New License. The Set License dialog box 
opens. 

 3 Type the new host license key.

 4 Click OK to set the new license key. Performance Center checks the validity 
of the license key and closes the dialog box.

Performance Center updates the host license on all the relevant host 
machines. To verify that the set license action was successful, refer to the log 
at the bottom of the page.

The license is not updated on the following machines because they do not 
require a Host license:

➤ Load generators located over a firewall

➤ UNIX machines

➤ Standalone load generators
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7
Configuring Your Databases

This chapter provides recommendations for configuring Oracle and MS-SQL 
databases to work with Performance Center.

This chapter includes:

 ➤  Oracle Configuration on page 123

 ➤  MS-SQL Configuration on page 134

Oracle Configuration

This section provides the following recommendations for Oracle 
configuration:

➤ “Establishing Connectivity” on page 124

➤ “Setting Tablespaces” on page 125

➤ “Setting Oracle Database Instance” on page 125

➤ “Minimum Permissions Required for Oracle User” on page 125

➤ “Oracle Client with Other Client/Server on Same Machine” on page 128

➤ “Verifying the Oracle Character Set” on page 128

➤ “Configuring Oracle Memory Structures” on page 129

➤ “Collecting Oracle System Statistics” on page 130

➤ “Performing Daily Backups of your Oracle Database” on page 131

➤ “Restoring Oracle Database Backup” on page 131

➤ “Setting IWAM_<MachineName> Account Permissions” on page 132
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➤ “Upgrading Oracle to a Supported Version” on page 132

Note: If Oracle is installed on the intended Web or Administration Site 
Server machine, the IIS port will be in use by HTTPOra service. To use the 
machine as a Web or Administration Site Server, you must stop and disable 
the HTTPOra service, and then run IIS and start the Web or Administration 
Site Server installation.

Establishing Connectivity
When installing Performance Center on an Oracle database, you must 
establish connectivity between the products.

During the Oracle database installation, you configure a database instance. 
In addition to the database instance, a default user name (system) and 
password (manager) are also created.

The database instance creates an Oracle TNS name entry that refers to the 
instance. For example, if the name of the instance is “LoadTest” then an 
Oracle TNS entry referring to “LoadTest” is established.

The first time you enter Performance Center, you are asked to supply system 
configuration information. When supplying the name of the Database 
Server, enter the name of the instance.

To test that the TNS name entry is properly configured:

 1 Open a Command Prompt.

 2 Type

where instancename is the name of the current instance. 

sqlplus system/manager@instancename
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For each instance name that you enter, the Oracle server machine updates 
the tnsnames.ora file in the Oracle server directory with a new entry.

 3 Copy the tnsnames.ora file from the server to each Oracle client machine 
that hosts a Performance Center server or host. Copy it into the 
..\oracle\ora9\network\ADMIN\tnsnames.ora. folder. 

 4 Verify that you are successfully logged on to Oracle.

Setting Tablespaces
In the system configuration, you will need to specify your database type and 
server name. If you are working with an Oracle database, the USERS and 
TEMP tablespaces must exist in the database.

Setting Oracle Database Instance
To avoid autostart errors and Oracle database errors on the Administration 
Site when using the autostart feature, it is recommended to increase the 
value of the processes property in Oracle database instance to 300. 

Minimum Permissions Required for Oracle User
When installing Performance Center, you need to provide an Oracle user 
with sufficient permissions to perform certain administrative tasks. In most 
cases, the system administrator cannot be used due to security concerns. 
Therefore, another Oracle user ("PCMANAGER") must be created to perform 
these tasks. This user must be granted the following Oracle permissions:

➤ create user with admin option

➤ create table with admin option

INST2.HP.CO.IL =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = orch3)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVICE_NAME = inst2.HP.co.il)
    )
  )
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➤ create session with admin option 

➤ create view with admin option

➤ alter user

➤ drop user

➤ select from dba_free_space

➤ select from dba_tablespaces

In addition, this user must also be granted the following roles:

➤ connect

➤ resource

These user permissions can be assigned by the database administrator 
(SYSDBA) to the Performance Center administrator by running the 
following statements:

CREATE USER "PCMANAGER" PROFILE "DEFAULT" IDENTIFIED BY "pass" 
DEFAULT TABLESPACE "USERS" TEMPORARY 
TABLESPACE "TEMP" ACCOUNT UNLOCK;

GRANT CONNECT, RESOURCE TO "PCMANAGER" WITH ADMIN OPTION;

GRANT CREATE SESSION TO "PCMANAGER" WITH ADMIN OPTION;

GRANT CREATE TABLE TO "PCMANAGER" WITH ADMIN OPTION;

GRANT CREATE VIEW TO "PCMANAGER" WITH ADMIN OPTION;

GRANT CREATE USER TO "PCMANAGER" WITH ADMIN OPTION;

GRANT SELECT ON "SYS"."DBA_FREE_SPACE" TO "PCMANAGER";

GRANT SELECT ON "SYS"."DBA_TABLESPACES" TO "PCMANAGER";

GRANT ALTER USER TO "PCMANAGER";

GRANT DROP USER TO "PCMANAGER";
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To verify that the new user, "PCMANAGER", was created successfully with 
the required Oracle permissions, you can try and perform the following 
tasks with the newly created user:

➤ Permission to select from dba_users: 

➤ Permission to drop user: 

➤ Permission to create users: 

Note: If the temporary table space is different to the default table space, 
then there is an unlimited quota on the temporary table space. 

➤ Permissions to grant create table, create view, and create session: 

 SELECT USERNAME FROM DBA_USERS 

 DROP USER <dbUser> CASCADE 

 CREATE USER <dbUser> IDENTIFIED BY password DEFAULT TABLESPACE 
<tableSpace>

   TEMPORARY TABLESPACE <tempTableSpace> QUOTA UNLIMITED ON 
<tableSpace>

   QUOTA UNLIMITED ON <tempTableSpace> 

GRANT CREATE TABLE TO <dbUser>

GRANT CREATE VIEW TO <dbUser>

GRANT CREATE SESSION TO <dbUser> 
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Oracle Client with Other Client/Server on Same Machine
The Oracle client used to connect with the Performance Center database 
may be installed on the same machine as other Oracle clients or servers. In 
this case, you need to define the value of the ORACLE_HOME system 
variable as the installation path of the Oracle client used to connect with 
Performance Center.

For example, if the installation path to the Oracle client used to connect 
with Performance Center is C:\ORACLE\product\10.2\client_1, define the 
ORACLE_HOME system variable as follows:

Verifying the Oracle Character Set
If you are using an Oracle database, ensure that the character set defined on 
the Oracle clients corresponds with the character set defined on the Oracle 
server. 

To verify that the Oracle character sets correspond:

 1 Verify the Oracle server character set as follows:

 a On the Oracle server run the following query:

 b Verify the value of the NLS_CHARACTERSET parameter. For example, the 
value may be UTF8.

 2 On all the Oracle client machines (all Performance Center User Site and 
Administration Site machines), verify the Oracle client character set as 
follows:

 a Select Start > Run and type REGEDIT to launch the Registry Editor.

 b In the Registry Editor, navigate to the following directory:

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\<oracle home>  

For example: HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\
KEY_OraClient10g_home1

ORACLE_HOME="C:\ORACLE\product\10.2\client_1"

select * from nls_database_parameters where parameter like '%CHARACTERSET'
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 c Find the key NLS_LANG and verify its value, for example 
AMERICAN_AMERICA.WE8MSWIN1252.

 3 If the character set values determined above do not correspond, change the 
character set value on the Oracle client machines. 

For example, if the value on the server is UTF8 and the value on the client is 
AMERICAN_AMERICA.WE8MSWIN1252, change the value on the client to 
AMERICAN_AMERICA.UTF8.

Configuring Oracle Memory Structures
Oracle uses memory to store information such as the following:

➤ Program code 

➤ Information about a connected session, even if it is currently inactive 

➤ Information needed during program execution (for example, the current 
state of a query from which rows are being fetched) 

➤ Information that is shared and communicated among Oracle processes 
(for example, locking information) 

➤ Cached data that is also permanently stored on peripheral memory (for 
example, data blocks and redo log entries) 

The basic memory structures associated with Oracle include:

➤ System Global Area (SGA), which is shared by all server and background 
processes and holds the following: 

➤ Database buffer cache 

➤ Redo log buffer 

➤ Shared pool 

➤ Large pool (if configured)

➤ Java pool

➤ Program Global Areas (PGA), which is private to each server and 
background process
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It is recommended that you consult with the database administrator before 
configuring your Performance Center database. The database administrator 
should use the following general guidelines for configuring the database:

➤ Shared pool size (shared_pool_size): minimum 200M 

➤ Database buffer cache size (db_cache_size): minimum 500M

➤ PGA size (pga_aggregate_target): minimum 200M

➤ Java pool size (java_pool_size): Decrease to the minimum value possible 
as Performance Center doesn’t use Java Code or JVM on the database 
therefore it does not need this pool

To view the values of these parameters, log in using SYSTEM user and use 
the following command from SQLPlus client:

To set the values of these parameters, use the following command:

Oracle server has to be restarted for the changes to be applied.

Collecting Oracle System Statistics
Oracle System Statistics allow Oracle Cost Based Optimizer to execute 
queries in an efficient manner. This can significantly contribute to Oracle 
performance, resulting in better response times while using Performance 
Center. Oracle System Statistics are automatically collected in version 10g. If 
you are running Oracle 9i, it is recommended that you collect Oracle System 
Statistics manually.

To collect Oracle System Statistics, use the following command from 
SQLPlus client while logged in using SYSTEM user

It is recommended to run a job that collects statistics daily, after work hours.

sho parameter <parameter_name> 

alter system set <parameter_name>=<value> scope=spfile; 

exec dbms_stats.gather_schema_stats(‘MI_LRDB’, cascade=>true)
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Performing Daily Backups of your Oracle Database
In case of hardware failure or any other serious problem, there needs to be a 
way to recover lost data. Therefore, it is important to maintain backups of 
the database. Performing daily backups on the database is a way to 
guarantee data protection.

Note: Make sure that your database backup is in sync with your file system 
backup.

To back up your Oracle database:

 1 Make sure your log mode is ARCHIVELOG.

 2 Write a hotbackup.bat file and hotbackup.sql file.

 3 Schedule the backup to run at night.

 4 Go to the Control Panel, select Scheduled Tasks, and click Add Scheduled 
Task.

 5 Select hotbackup.bat as the program to run.

 6 Select daily and enter a time where the file system will not be heavily used 
(for example,3:00 am).

 7 Make sure that the Task Scheduler service is started and set to automatic.

Restoring Oracle Database Backup
If you migrated your database and you encountered an error, you can restore 
the database backup files.

To restore the backup database files:

 1 Drop user MI_LRDB.

 2 Create a new empty user and name it MI_LRDB.

 3 Import the backed up database into the new user.

 4 Repeat the migration process. See “Performing Database Migration” on 
page 107.
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Setting IWAM_<MachineName> Account Permissions
It is recommended to change the IWAM_<MachineName> account 
permissions, to give the IWAM_<MachineName> user read/write/execute 
privileges on the Oracle home directory and all its sub-directories.

 1 In Windows Explorer, navigate to the Oracle home directory, right-click, 
and select Properties.

 2 Select the Security tab.

 3 Click Add and add the IWAM_<SERVER> user.

 4 Select Read & Execute and Write.

 5 Click OK.

Upgrading Oracle to a Supported Version
Performance Center 9.10 supports Oracle 9.i or 10g on Windows or UNIX. If 
you are using an older unsupported version of the database, you need to 
upgrade your database to a supported version.

To upgrade an Oracle database to a supported version:

 1 Drop user MI_LRDB.

If the database that you are migrating to already has an MI_LRDB user, you 
must first drop the user and then recreate the user. 

Connect to the new database using SQLPlus, and run the following 
command:

 2 Create a new user.

On the new database create a new user, MI_LRDB, with password 
MIOrchid#1.

Connect to the new database using SQLPlus, and run the following 
command:

DROP USER MI_LRDB CASCADE;

CREATE USER MI_LRDB IDENTIFIED BY MIOrchid#1
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 3 Grant MI_LRDB user DBA privileges.

Connect to the new database using SQLPlus, and run the following 
command:

 4 Export the old Performance Center database.

From the command line run: 

where <oldTNS> corresponds to the name given in the tnsnames.ora file 
that identifies the old Oracle server to which you want to connect for 
exporting data.

 5 Import the database backup file that you created earlier (.dmp file) to the 
new Oracle database.

From the command line run:

where <newTNS> corresponds to the name given in the tnsnames.ora file 
that identifies the new Oracle server to which you want to connect for 
importing data.

 6 Create a TNS entry for the new database.

Copy or create a TNS entry for the new database in the tnsnames.ora file on 
all Performance Center Servers and Controller machines. Verify connectivity 
from each Performance Center Server and Controller Host by using 
SQLPLUS:

 7 Check that all servers and hosts have a supported Oracle client installed.

Performance Center supports Oracle 8i, 9i and 10g client. However, it is 
recommended to use Oracle 10g R2 client.

GRANT DBA TO MI_LRDB

% exp MI_LRDB/MIOrchid#1@<oldTNS> file=<Name of dump file>.dmp

% imp MI_LRDB/MIOrchid#1@<newTNS> file=<Name of dumpfile>.dmp full=y

% SQLPLUS MI_LRDB/MIOrchid#1@<newTNS>
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 8 (Optional) Add ORACLE/BIN directory into your PATH environment. 

Add ORACLE/BIN directory into your PATH environment, and remove 
SQLPLUS from <Performance Center directory>/DBSetup directory. This 
ensures that Performance Center uses the version of SQLPLUS that is 
installed on your system. 

Make sure that IWAM_<machine> has full access to Oracle directories.

MS-SQL Configuration

This section provides the following recommendations for MS-SQL 
configuration:

➤ “Working with a Non-Default MS-SQL Instance Name” on page 135

➤ “Minimum Permissions Required for MS-SQL User in Performance Center” 
on page 137

➤ “Performing Daily Backups of Your MS-SQL Database” on page 139

➤ “Restoring MS-SQL Database Backup” on page 140

➤ “Changing the Database Model Compatibility Level” on page 141
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Working with a Non-Default MS-SQL Instance Name
If the Performance Center database is an MS-SQL database with a non-
default instance name, configure the database server in one of the following 
ways: 

➤ <server name>, <instance port>

➤ <server name>\<instance name>:

Notes:

➤ Ensure that the relevant service packs are installed on all MS-SQL 
instances.

➤ Configure the other machines (the non-database machines) with the 
alias.

If you are working with a non-default instance name, you also need to 
configure the Performance Center Adminsitration Site Server to 
communicate with the MS-SQL database server.

To configure the Adminsitration Site Server for MS-SQL:

 1 From the Windows Start menu, select Run and enter the following 
command:

cliconfg.exe
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The SQL Server Client Network Utility dialog box opens.

 2 In the General tab, enable the TCP/IP and Multiprotocol protocols. If these 
protocols appear in the Disabled protocols list, double-click them to move 
them to the Enabled protocols by order list and click Apply.

 3 In the Alias tab, click Add to open the Add Network Library Configuration 
dialog box.
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➤ In the Network libraries area, select TCP/IP.

➤ In the Server alias box, enter the SQL server name in the following 
format:

➤ Click OK. The Add Network Library Configuration dialog box closes.

 4 In the SQL Server Client Network Utility dialog box, click OK.

Minimum Permissions Required for MS-SQL User in 
Performance Center 
When installing Performance Center, you need to provide an MS-SQL user 
with sufficient permissions to perform certain administrative tasks. In most 
cases, the system administrator cannot be used due to security concerns. 
Therefore, another MS-SQL user (<pc_admin>) must be created to perform 
these tasks. This user must be granted the following MS-SQL server roles:

➤ Database Creators 

➤ Process Administrators (required for creating the td user (dbOwnerName))

These user permissions can be assigned by the database administrator to the 
Performance Center administrator (<pc_admin>) as follows:

 1 Open the Enterprise Manager.

 2 Open Console Root > Microsoft SQL Servers > SQL Server Group > 
<machine name> > Security > Logins.

 3 Right-click the <pc_admin> user and select Properties.

 4 In the Server Roles tab, enable the Database Creators and Process 
Administrators options.

 5 Click OK. 

To verify that the new user was created successfully with the required MS 
SQL permissions, you can try and perform the following tasks with the 
newly created user:

<SQL server machine name>\<instance name>
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MS SQL Server Authentication:

➤ Permission to select from the sysdatabases table in the master database: 

➤ Permission to drop the database: 

➤ Permission to select from syslogins: 

Note: By default, the dbOwnerName is td. 

➤ Permission to create a database: 

MS SQL with Windows Authentication:

➤ Permission to change the database context. 

➤ Permission to select from syslogins: 

➤ Permission to select from sysusers: 

➤ Permission to grant all to user td. 

 SELECT name FROM sysdatabases where name='<dbName>'

 "DROP DATABASE " + dbName 

 SELECT COUNT(*) FROM master..syslogins WHERE name='<dbOwnerName>' 

 CREATE DATABASE <dbName>

 USE <dbName> 

 SELECT COUNT(*) FROM master..syslogins WHERE name='<dbOwnerName>' 

 SELECT COUNT(*) FROM master..sysusers WHERE name='<dbOwnerName>' 

 GRANT ALL TO <dbOwnerName> 
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➤ Permission to create a database: 

Performing Daily Backups of Your MS-SQL Database
In case of hardware failure or any other serious problem, there needs to be a 
way to recover lost data. Therefore, it is important to maintain backups of 
the database. Performing daily backups on the database is a way to 
guarantee data protection.

Note: Make sure that your database backup is in sync with your file system 
backup.

To back up your MS-SQL database:

 1 Launch Microsoft SQL Server > Enterprise Manager.

 2 Select the SQL Server that has MI_LRDB database.

 3 Select the Management folder.

 4 Right-click backup, and select Backup a Database.

 5 Under the General tab, select MI_LRDB as the database.

 6 Click Add, and enter a name for the location where the backup will be 
saved. This should be on a different computer to the database.

 7 Check the schedule box.

 8 Edit and define the schedule for the backup.

 9 Click OK.

 10 Make sure that the SQLSERVERAGENT service is running. Set it to automatic.

 CREATE DATABASE <dbName> 
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Restoring MS-SQL Database Backup
If you migrated your database and you encountered an error, you can restore 
the database backup files.

To restore the backup database files:

 1 Open Microsoft SQL Server > Enterprise Manager and select Databases.

 2 Right-click MI_LRDB (if it exists), and select Delete.

 3 Create a new database and name it MI_LRDB.

 4 Right-click the new database and select All Tasks > Import Data.

 5 Follow the wizard, and specify the backed up database as the source 
database.

 6 Under Security > Logins, ensure that OrchidUser has public and db_owner 
permissions for the MI_LRDB database.

 7 Repeat the migration process. See “Performing Database Migration” on 
page 107.
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Changing the Database Model Compatibility Level
If you are using SQL Server 2005 SP2, you need to define the Compatibility 
level of the database model as SQL Sever 2000 (80). You do this before you 
install and configure Performance Center.

To change the database compatibility level to SQL Server 2000 (80):

 1 In Microsoft SQL Server Management Studio, right-click Databases > System 
Database > model and select Properties.

 2 In the Database Properties dialog box, in the Select a page area, select 
Options. 
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 3 In the Compatibility level box, select SQL Server 2000 (80).

Notes: 

➤ After you have completed the initial configuration of the Performance 
Center system as described in Chapter 6, “Required Configuration,” you 
can restore the original compatibility level setting.

➤ If you have already configured Performance Center and the database has 
been created, you can still change the compatibility level as follows: In 
Microsoft SQL Server Management Studio, right-click 
Databases > MI_LRDB select Properties, and continue with step 2 above. 
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8
Recommended Configuration

The Performance Center system has a default set of configuration settings. 
These settings work for the purposes of utilizing Performance Center with its 
intended purpose. This chapter includes additional tuning and 
configuration recommendations to help you get the most out of your 
Performance Center system. The use of these recommendations depends on 
each specific business case. Not all the recommendations in this chapter are 
suitable for all usage scenarios and the Performance Center administrator 
should therefore assess which of these recommendations will contribute to 
their specific needs.

This chapter includes:

 ➤  Windows XP Professional SP2 Configuration on page 144

 ➤  Configuring IIS on Performance Center Machines to Use SSL on page 145

 ➤  Identifying the SiteScope Account Name on page 149

 ➤  Working with Performance Center Agent on page 150

 ➤  File System Configuration on page 152

 ➤  Installing Multiple Components on One Machine on page 158

 ➤  Naming Performance Center Machines on page 158

 ➤  Modifying Default Heap Sizes on page 159

 ➤  Working with McAfee VirusScan Enterprise 8.0 on page 160

 ➤  Web Server Configuration on page 160
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Windows XP Professional SP2 Configuration

If you are running Windows XP Service Pack 2 (SP2), the Windows Firewall 
is turned on by default. The firewall does not allow Performance Center 
components to function as designed and must be turned off on all host 
machines on which the upload/download features are used.

Note: Turning off the Windows Firewall increases the risk to your 
computer's security. 

To turn off the Windows Firewall: 

 1 Select Start > Settings > Control Panel > Security Center (not in Advanced 
look of Control Panel).

 2 Click Windows Firewall.

 3 In the General tab select Off.

For each process that needs the firewall, you can unblock the process by:

➤ clicking the unblock button in the popup window that indicates that the 
program needs it

➤ tuning the Windows Firewall manually from the Exceptions tab
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Configuring IIS on Performance Center Machines to Use SSL

Performance Center host and server machines all require IIS (Microsoft 
Internet Information Server) to be installed. You can configure the following 
IIS Performance Center virtual directories to use SSL (Secure Socket Layer):

➤ PCWS. Exists on all Performance Center hosts and servers.

➤ Admin. Exists on the Performance Center Administration Site Server.

➤ LoadTest. Exists on the Performance Center User Site Server.

This section describes how to configure Performance Center IIS virtual 
directories to use SSL and the the actions you need to complete before and 
after configuring.

Before You Configure IIS
IIS uses port 443 to work over SSL. However, certain Performance Center 
components may also be configured to use this port. Therefore, you need to 
ensure that port 443 is available to be used by IIS and configure these 
Performance Center components to use a different port other than 443.

The following Performance Center components may be configured to use 
port 443:

➤ Performance Center agent. Resides only on Performance Center host 
machines. 

➤ Remote Management agent. Resides on all Performance Center host and 
server machines.
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Changing the Port on the Performance Center Agent

On all Performance Center host machines, you need to change the port 
being used by the Performance Center agent for over firewall 
communication.

To change the port on the Performance Center agent:

 1 On the Performance Center host machines, go to the directory 
<Performance Center installation directory>\launch_service\dat and open 
the file mdrv.dat in a text editor.

 2 In the [launcher] section add the following line:

where <port_number> is the port you want to open. Enter a number other 
than 443.

 3 In the same directory, open the file channel_configure.dat in a text editor.

 4 In the [General] section add the following line:

where <port_number> is the port you want to open. Enter the same number 
that you entered in step 2, above.

 5 Restart the Performance Center agent service for the configuration changes 
to take effect. To restart the service, select Start > Run and type services.msc. 
The Services dialog box opens. Locate the service Performance Center Agent 
Service and restart it.

Changing the Port on the Remote Management Agent

On all Performance Center host and server machines, you need to change 
the port being used by the Remote Management agent for over firewall 
communication.

To change the port on the Remote Management agent:

 1 On the Performance Center host and server machines, go to the directory 
<Performance Center installation directory>\al_agent\dat and open the file 
mdrv.dat in a text editor.

OFWPort=<port_number>

OFWPort=<port_number>
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 2 In the [launcher] section add the following line:

where <port_number> is the port you want to open. Enter a number other 
than 443. Do not use the same number that you used for the Performance 
Center agent.

 3 In the same directory, open the file channel_configure.dat in a text editor.

 4 In the [General] section add the following line:

where <port_number> is the port you want to open. Enter the same number 
that you entered in step 2, above.

 5 Restart the Remote Management agent service for the configuration changes 
to take effect. To restart the service, select Start > Run and type services.msc. 
The Services dialog box opens. Locate the service RemoteManagement 
Agent Service and restart it.

Configuring IIS to Work Over SSL
This section describes the basic steps involved in setting up IIS on 
Performance Center server and host machines to use SSL. 

To configure IIS to use SSL on Performance Center machines:

 1 Create the SSL certificate.

 2 Install the certificate you created onto the relevant machine that you are 
configuring for SSL.

 3 Install the certificate on all other Performance Center hosts and servers that 
will need to communicate with the relevant machine that you are 
configuring for SSL.

The certificate should appear in the Microsoft Management Console under 
Certificates (Local Computer) > Trusted Root Certification.

OFWPort=<port_number>

OFWPort=<port_number>
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For example, if you were configuring the Administration Site to work over 
SSL, you would generate the SSL certificate, install it on the Administration 
Site, and then you would install it on all the Performance Center hosts and 
servers, such as the Utility Server, that interact with the Administration Site.

After You Configure IIS
After you configure IIS to use SSL, you need to ensure that the IIS sub-virtual 
directories used by Performance Center on the Administration Site Server 
and the User Site Server have the correct connection details.

On the Administration Site Server you need to verify the connection details 
of the Admin > Graphs sub-virtual directory.

On the User Site Server you need to verify the connection details of the 
following sub-virtual directories:

➤ LoadTest > Graphs

➤ LoadTest > FileServer

➤ LoadTest > DashboardGraphs

➤ LoadTest > Downloads

➤ LoadTest > ReportVirt

To verify the connection details of the IIS sub-virtual directories:

 1 Go to the relevant sub-virtual directory.

 2 Right-click the sub-virtual directory, and select Properties. The Graphs 
Properties dialog box opens.

 3 In the Virtual Directory tab, click Connect As. The Network Directory 
Security Credentials dialog box opens.

 4 Ensure that the username is the Performance Center system user (by default, 
IUSR_METRO)

 5 Verify that the password is filled in. If the Password box is empty, enter the 
correct password. If you are using the default Performance Center system 
username (IUSR_METRO), and you do not know the password, contact 
Customer Support.
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Identifying the SiteScope Account Name

This section describes how to identify the SiteScope account name for a 
particular SiteScope user.

To identify a SiteScope account name:

 1 Log on to SiteScope as follows: <SiteScope server>:8888/sitescope.

 2 Click the Preferences button, and then select the Users link.

 3 The User Profiles page shows a table that displays the Login URL associated 
with each user name. Inside the Login URL you can identify the account 
name. In the above example, the account name for the user, TestUSer is 
login1.
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Working with Performance Center Agent

The Performance Center Agent runs on the load generators and enables 
communication between the Controller, load generators, and MI Listeners 
(in firewall configurations). The agent receives instructions from the 
Controller to initialize, run, pause, and stop Vusers. At the same time, the 
agent also relays data on the status of the Vusers back to the Controller. 

To check the agent’s current configuration, move your mouse over the 
Agent’s icon in the Task Bar area, and read the description. The description 
will say either Performance Center Agent Service or Performance Center 
Agent Process.

Changing the Performance Center Agent Password
To change the password of the Performance Center Agent service:

 1 Select Start > Settings > Control Panel > Administrative Tools > Services > 
Performance Center Agent Service.

 2 Click Startup to open the Services dialog box.

 3 Enter a new user name and password, then click OK.

 4 Stop and restart the service.

Running the Performance Center Agent as a Process
In some cases, such as SAPGUI replay, running GUI Vusers on remote 
machines, or terminal sessions, the Performance Center Agent must run as a 
process.

To change the Performance Center Agent from a service to a process:

➤ From the Start > Run menu, run <PC_dir>\launch_service\bin\
magentproc.exe.
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Running the Performance Center Agent as a Service
In most cases, the Performance Center Agent runs as a service.

To change the Performance Center Agent from a process to a service:

 1 Stop the agent process by right-clicking its icon in the system tray and 
selecting Close.

 2 To uninstall the process, delete its shortcut from the system startup folder.

 3 To install the service, run <PC_dir>\launch_service\bin\magentservice.exe 
-install <user_domain>\<user_name> <password> 

This also runs the agent service.

 4 To run the service later, after stopping it, start it from the Services dialog 
box.

Configuring the Agent on Load Generator Machines
When working with protocols that use network files or Web protocol Vusers 
that access the Internet through a proxy server, the Load Generator agent 
must have network privileges. Note that the default user created by 
Performance Center, IUSR_METRO, does not have network privileges. 

By default, the agent runs as a service on the Load Generator machines. You 
can either run the agent as a process or you can continue running the agent 
as a service. To continue running it as a service, configure it to run the 
session using the local system account or another user account with 
network access privileges.

Running SAPGUI Vusers
To run SAPGUI Vusers on a remote host, make sure of the following:

➤ The Performance Center agent is configured to run as a process (as 
described in “Running the Performance Center Agent as a Process” on 
page 150).

➤ A user with administrative privileges is logged on to the host machine 
during run-time. 
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Note: To run SAPGUI Vusers on a Localhost (Controller + Load Generator 
machine), the Controller must be configured to work as an Interactive User. 

1. Make sure wlrun process is not running on the machine.
2. Select Start > Run and type dcomcnfg.
3. Click Enter to display the list of DCOM applications.
4. In the displayed application list, double-click wlrun.LrEngine.
5. In the Identity tab, select The interactive user.
6. Click OK twice to close both dialog boxes.

Mapping Network Drives when Running Agent as Service
For all Windows platforms, when the user is logged off, the service cannot 
resolve the mapping of network drives. For Windows XP, the service also 
cannot resolve the mapping of network drives when the user is logged on. 

In cases when the service cannot work with mapped network drives, use the 
full path to the directory, for example, <\\<machine-name>\<directory>\>.

File System Configuration

This section provides the following recommendations for file system 
configuration:

➤ Modify Access to the Performance Center File System (LRFS)

➤ Set Up Daily Backups

➤ Using a Network Drive as the File Server

Modify Access to the Performance Center File System 
(LRFS)

In order to secure the data on LRFS, access to it should be limited. Full access 
(Read, Write, Execute, and Modify) should be granted only in specific cases 
where necessary. 
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To define access permissions:

 1 In Windows Explorer, right-click the LRFS directory and select Properties.

 2 Click the Security tab. Add or remove users and/or groups, giving them the 
minimum access that is required.

 3 Click the Sharing tab. In this tab you can grant users and/or groups different 
permissions for accessing the drive over the network. Give only the 
minimum access that is needed. By default, only the Performance Center 
system user has access.

Set Up Daily Backups
It is important to maintain backups of the LRFS file system. If there is 
hardware failure or any other serious problem, there needs to be a way to 
recover the data. Performing daily backups on the LRFS file system is a way 
to guarantee data protection. The Tc_BackupFileSystem.vbs script is 
provided to execute daily backups of the file system.

 1 Select Start > Settings > Control Panel > Scheduled Tasks > Add Scheduled 
Task.

 2 Under WinNT\system32, select CScript.exe as the program to run.

 3 Type a descriptive name for the task such as Performance Center LRFS 
Backup.

 4 Select Daily and enter a time when the file system will not be heavily used 
(for example, 3:00 am).

Note: Make sure that your file system backup is in sync with your database 
backup.
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 5 Select Open advanced properties for this task when I click Finish. 
Alternatively, right-click the newly created task and select Properties.

 6 Edit the Run field, in the Task tab, and enter Tc_BackupFileSystem.vbs 
(including the full path), the source directory and the destination directory, 
for example:

 7 Make sure that the Task Scheduler service is started and set to automatic.

Using a Network Drive as the File Server

You can configure the Performance Center system to use a network drive as 
the File Server.

To configure Performance Center to use a network drive as a file server:

 1 Install the Performance Center File Server component on the same machine 
as another Performance Center component. The FIle Server installation 
creates the LRFS directory in the Performance Center installation directory.

 2 Using the File Server that you installed above, complete the initial 
configuration of the Performance Center system as described in Chapter 6, 
“Required Configuration.”

C:\WINNT\system32\cscript.exe D:\HP\bin\Tc_BackupFileSystem.vbs 
D:\HP\Performance Center\LRFS Y:\HPBackup\LRFS
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 3 From the machine on which you installed the file server, copy the LRFS 
directory and paste it onto the designated network drive.

 4 On the network drive, share the LRFS directory and set full permissions for 
the Performance Center system user (by default, IUSR_METRO) as follows:

 a Right-click the LRFS directory and select Properties.

 b In the Properties dialog box, in the Sharing tab, select the Share this 
folder option and click Permissions.

 c In the Permissions dialog box, add the Performance Center system user 
with full permissions and click OK.

 d In the Properties dialog box, in the Security tab, add the Performance 
Center system user with full permissions and click OK.

Note: You can verify that the permissions were correctly set by mapping 
the LRFS folder on the network drive from other Performance Center 
servers, using the Performance Center system user. If you can add or 
remove folders on the mapped drive, the permissions have been set 
correctly.

 5 on the original machine on which you installed the File Server, update the 
<Performance Center installation directory>\bin\SmartDiskConf.ini file as 
follows:

 a In the MonitoredDirectries section, set the BasePath property as the 
location of the LRFS directory on the network drive, for example:

 b Save the SmartDiskConf.ini file.

 c Restart the SmartDiskCleaner service

[MonitoredDirectries]
BasePath=\\PCNetWork\PC_FS\LRFS\
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 6 Connect to the Performance Center database (MI_LRDB scheme). Open the 
GlobalData table, and change the following entry values to represent the 
location of the File Server on the network drive:

where <Network_Path> is the network location of the File Server directory 
(LRFS). 

For example if the Network path was \\PCNetWork\PC_FS the value for 
MainDir would be \\PCNetWork\PC_FS\LRFS\

 7 On the User Site server and the Administration Site server, change the File 
Server location of the relevant IIS Performance Center virtual directories to 
represent the location of the File Server on the network drive.

On the User Site server, change the File Server location on the following 
virtual directories:

➤ LoadTest > DashboardGraphs

➤ LoadTest > Downloads

➤ LoadTest > FileServer

➤ LoadTest > Graphs

➤ LoadTest > ReportVirt

On the Administration Site server, change the File Server location on the 
following Admin> Graphs virtual directory:

To change the File Server location of the virtual directories:

 a Open the Internet Service Manager (Select Start > Run, type inetmgr and 
press ENTER). 

 b Right-click the virtual directory and select Properties. 

Entry Value

FSName                                            <Network_Path>

MainDir                                           <Network_Path>\LRFS\

UploadDir                                         <Network_Path>\LRFS\UploadDir

TempGraphDir                                      <Network_Path>\LRFS\graphs
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 c In the Virtual Directory tab, in the Network Directory box, change the 
location to represent the location of the File Server on the network drive. 
For example:

 d Click Connect as and ensure that the Performance Center system user 
credentials are filled in. 

 e Click OK to save the changes.

 f Reset IIS.

 8 On all Performance Center servers and hosts, update the connection to the 
File Server in the globals.ini file as follows:

Note: If you have many hosts in your database, instead of changing the 
globals.ini file, you can remove all the hosts and add them again on the 
Hosts page in the Administration Site. When you re-add the hosts, the File 
Server location is updated automatically on each host.

 a Select Start > Run, type globals.ini, and press ENTER.

 b In the Drives section, set the SharedPath property as the location of the 
LRFS directory on the network drive, for example:

Important: In the Administration Site Server Configuration page (System 
Configuration > Server Configuration), if you click Reset, the original 
location of the File Servers is restored on all the Performance Center servers 
and the new network drive location is removed from the globals.ini file and 
from the IIS virtual directories.

\\PCNetWork\PC_FS\LRFS\DashboardGraphs

[Drives]
SharedPath=\\PCNetWork\PC_FS\LRFS\
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 9 Verify that you have correctly configured you Performance Center 
environment to use a network drive as the File Server:

➤ In the Administration Site, go to the Event Log page (Site Management > 
Event Log) and click Export Event Log. If the Event log is ready for 
download, the File Server is correctly configured.

➤ In the User Site, go to the Vuser Scripts page (Project > Vuser Scripts) and 
upload a new script. In the Load Test Results page (Load Tests > Search 
Results), open an HTML report for one of the load tests. If these actions 
were completed successfully, the File Server is correctly configured.

Installing Multiple Components on One Machine

All Performance Center components include the configurable file, 
globals.ini. If you install a component on a machine which already includes 
a configured Performance Center component, the existing globals.ini file 
that contains the configuration information is overwritten by the new one.

To avoid having to reconfigure existing components, save your configured 
globals.ini file, and copy it back after installing the new component. The 
globals.ini file is located in the <Performance Center Installation 
Directory>\bin directory.

Naming Performance Center Machines

It is easier to locate, troubleshoot, and manage Performance Center 
machines if you give them meaningful names. Meaningful names can be 
derived from the location, purpose, type, and identity of the machine. 

For example, if the Performance Team has four Performance Center Web 
servers in California, the names of these servers might be:

PTCAPCWeb1, PTCAPCWeb2, PTCAPCWeb3, and PTCAPCWeb4

PT = Performance Team 
CA = California
PCWeb = Performance Center Web Server
1-4 = a unique number for each web server
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Other keywords might be added to a machine’s name, such as software, 
operating system, and so on. There are a variety of ways to name machines. 
The more information that is provided with a name, the easier the system 
will be to use and maintain. Make sure that the names themselves are easy 
to remember and not too long.

Modifying Default Heap Sizes

This section provides instructions about how to modify the default heap 
sizes for your desktop processes.

To modify the default heap sizes for your desktop processes:

 1 Select Start > Run and type REGEDIT to launch the Registry Editor.

 2 Go to: 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session 
Manager\SubSystems

 3 Edit the Windows value, as follows:

➤ Right-click the Windows value and select Modify. The Edit String dialog 
box opens.

➤ In the Value data string there is a variable called SharedSection.

The first value is the heap size of all common desktops, the second value 
is the heap size of all desktops associated with interactive mode and the 
third value is the heap size of all desktops associated with noninteractive 
mode.

➤ There should be at least 3 values in this section.
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➤ Set them to 2048,4096,2048 respectively (or as appropriate, depending 
on available RAM).

Working with McAfee VirusScan Enterprise 8.0 

The McAfee VirusScan Enterprise 8.0 includes a buffer overflow protection 
module, which is incompatible with the Performance Center User Site. You 
can either upgrade to McAfee VirusScan Enterprise 8.5i patch 4 or perform 
the following workaround on version 8.0. 

In McAfee VirusScan Enterprise 8.0, go to the properties of the buffer 
overflow protection module and add the following three exception rules: 
(Click Add exclusion to add an exception rule.)

Web Server Configuration

This section provides the following recommendations for Web server 
configuration:

This section contains:

➤ “Set a Reasonable Connection Timeout” on page 161

➤ “Set a Reasonable Session Timeout” on page 161

➤ “Set Hits Expected Per Day” on page 162

process=w3wp.exe
api=recv
module=heap

process=w3wp.exe
api=select
module=heap

process=w3wp.exe
api=send
module=heap
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➤ “Set the ASP Upload Buffer” on page 162

Set a Reasonable Connection Timeout
You should set a reasonable connection timeout of between 60-600 seconds 
for the default Web site. Setting the connection timeout too high (for 
example, 3600) will only deplete unnecessary TCP/IP control blocks / 
connection handles.

To set the connection timeout:

 1 Select Start > Programs > Administrative Tools > Internet Services Manager. 
The Internet Services Manager administrative tool opens.

 2 Right-click <Default Web Site> and select Properties.

 3 Click the <Default Web Site> tab.

 4 Set a reasonable connection timeout (for example, 60 or 120 seconds).

Set a Reasonable Session Timeout
You should set a reasonable session timeout of between 15-30 minutes for 
the default Web site. Avoid long session timeouts in excess of 60 minutes. 
Long session timeouts can consume unnecessary resources on the IIS 
application server for extended periods of time (even after the user has 
disconnected from the site).

To set the session timeout:

 1 Select Start > Programs > Administrative Tools > Internet Services Manager. 
The Internet Services Manager administrative tool opens.

 2 Right-click <Default Web Site> and select Properties.

 3 Click the Home Directory tab.

 4 Under Application Settings, click Configuration, and select the App Options 
tab.

 5 Select Enable session state, and set the appropriate session timeout.
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Set Hits Expected Per Day
As more users use Performance Center and live load tests, hits on the 
Performance Center Web server increase dramatically. By default, live load 
tests are refreshed every five seconds, and typically load tests run for 1-4 
hours. So, for example, if you have five concurrent load tests being viewed 
(or one load test being viewed from five different browsers), you will have 
3,600 hits on the Web server in one hour. Accordingly, you should increase 
the setting for hits expected per day.

To increase the hits expected per day:

 1 Select Start > Programs > Administrative Tools > Internet Services Manager. 
The Internet Services Manager administrative tool opens.

 2 Right-click <Default Web Site> and select Properties.

 3 Click the Performance tab, and in the Performance tuning section, set hits 
expected per day to More than 100,000. 

Set the ASP Upload Buffer
Set the ASP upload buffer to the maximum size of a file that you will permit 
to be uploaded to the server. 

To set the ASP upload buffer:

 1 Select Start > Run and type REGEDIT. The Registry Editor opens.

 2 In the HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services 
\W3SVC\Parameters, check for the MaxClientRequestBuffer value.

If it does not exist, create it as a DWORD (Select Edit > New > DWORD Value 
from the menu).
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 3 Right-click the MaxClientRequestBuffer value, and select Modify. The Edit 
DWORD Value dialog box opens.

 4 In the Value data box, enter the number of bytes that you would like to 
upload.

For example, a value of 2097152 is 2Mb.
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9 
Working with Firewalls

You can set up your Performance Center system to run Vusers and monitor 
servers over a firewall.

This chapter includes:

 ➤  About Using Firewalls in Performance Center on page 167

 ➤  Example: Over Firewall Deployment on page 170

 ➤  Setting Up your System to Use Firewalls: Basic Steps on page 171

 ➤  Installing Over-Firewall Components on page 172

 ➤  Initial Configuration of the Over-Firewall System on page 173

About Using Firewalls in Performance Center

Working with a firewall means that you can prevent unauthorized access to 
or from a private network, on specific port numbers.

For example, you can specify that there is no access to any port from the 
outside world, with the exception of the mail port (25), or you can specify 
that there is no outside connection from any ports to the outside except 
from the mail port and WEB port (80). The port settings are configured by 
the system administrator.
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In a regular Performance Center load test scenario (not over a firewall), the 
Controller has direct access to the Performance Center agents running on 
remote machines. This enables the Controller to connect directly to those 
machines. 

When running Vusers or monitoring applications over a firewall, this direct 
connection is blocked by the firewall. The connection cannot be established 
by the Controller, because it does not have permissions to open the firewall. 

Performance Center solves this problem by using a communication 
configuration based on HTTPS or secured TCP/IP. This configuration uses 
the standard SSL port on the firewall (port 443). For more information on 
HTTPS and TCP/IP system configuration, see “Setting up your Deployment 
(TCP or HTTPS)” on page 174.

A Performance Center agent is installed on load generators running Vusers 
over a firewall, and on Monitor Over Firewall machines that monitor the 
servers that are located over a firewall. The agent communicates with the 
MI Listener machine through port 443 in the firewall. 
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The MI Listener is a component that serves as router between the Controller 
and the Performance Center agent. 

When the Performance Center agent connects to the MI Listener, the 
MI Listener keeps a listing of the connection to the agent using a symbolic 
name that the agent passed to it. 

When the Controller connects to the MI Listener, it communicates to the 
MI Listener through port 50500. 

The Controller uses a symbolic name for the agent, and provides the 
MI Listener machine’s name. If there has been a connection from the agent 
with the same symbolic name to this MI Listener, the connection is made 
between the Controller and the agent. Once you have a connection with the 
agent, you can run or monitor Vusers over a firewall. 
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Example: Over Firewall Deployment

The following diagram is a basic example of a Performance Center 
deployment over a firewall.  

As explained in the previous section, the Performance Center agent is 
installed on both the load generator machine and the Monitor Over Firewall 
machine. During installation, the Performance Center agent is added as a 
Windows service.

The MI Listener serves as a router between: 

➤ The agent on the load generator machine and the Controller, enabling 
the Controller to run Vusers over a firewall

➤ The agent on the Monitor Over Firewall machine and the Controller, 
enabling the Controller to monitor the servers that are located over a 
firewall

Controller

MI Listener

Firewall
Monitoring

Running 
Vusers

Load Generator 

 Agent 

Monitor Over 
Firewall Machine

 Agent 

Customer Server
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Setting Up your System to Use Firewalls: Basic Steps

Setting up your system to use firewalls involves the following stages of 
configuration:

➤ Installation and initial configuration. Installing the necessary components 
and doing initial configuration settings. See “Installing Over-Firewall 
Components” on page 172 and “Initial Configuration of the Over-Firewall 
System” on page 173.

➤ Running Vusers over a firewall. Setting up your system to run Vusers over a 
firewall when there is a firewall between the Controller and load generator 
host machines. See “Running Vusers Over a Firewall” on page 179.

Specify MI Listener details in Administration 
Site (Firewall Vusers Communicators)

Configure Performance Center Agent on 
Load Generator machine

Configure Load Generator Host on 
Administration Site

Running Vusers Over Firewall
Specify MI Listener details in Administration 

Site (Firewall Monitoring Communicator)

Configure Performance Center Agent on 
Monitor Over Firewall (MOFW) machine

Configure monitor settings on MOFW 
machine

Configure User Site to Receive MOFW 
Information

Monitoring Over Firewall

Install necessary components

Configure system for TCP or HTTPS

Configure Firewall to Allow Agent Access

Installation and Initial Configuration

Configure MI Listener
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➤ Monitoring over a firewall. Setting up your system to monitor the 
application under test (AUT) when there is a firewall between the Controller 
and AUT. See “Monitoring Over a Firewall” on page 187.

➤ Checking Connectivity. After installing and configuring all the necessary 
components, check that you are be able to establish a connection between 
the Performance Center agent, MI Listener, and the Controller machine. See 
“Checking Connectivity” on page 208.

The following flow chart provides a general outline of the steps that you 
need to carry out to set up your system to use firewalls.

Installing Over-Firewall Components

To enable over-firewall communication, ensure that you have installed the 
following Performance Center components:

➤ MI Listener. Serves as a router between the Controller and the 
Performance Center agent. You install the MI Listener component on a 
dedicated machine. For installation instructions, see Chapter 2, 
“Installing Performance Center on Windows.”

For instructions on configuring the MI Listener machine, see 
“Configuring the MI Listener” on page 177. 

➤ Monitor Over Firewall component. Used to monitor the servers that are 
located over a firewall. You install the Monitors over Firewall component 
on a dedicated machine. For installation instructions, see Chapter 2, 
“Installing Performance Center on Windows.”

For information about configuring the Monitor Over Firewall machine, 
see “Monitoring Over a Firewall” on page 187. 
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Initial Configuration of the Over-Firewall System

After you have installed the necessary components as described in 
“Installing Over-Firewall Components” on page 172, you are ready to 
configure your over-firewall system. 

To perform initial configuration of your over-firewall system:

 1 Configure your system according to TCP or HTTPS. 

See “Setting up your Deployment (TCP or HTTPS)” on page 174.

 2 Modify your firewall settings to enable communication between the 
machines on either side of the firewall. 

See “Configuring the Firewall to Allow Agent Access” on page 176.

 3 Configure the MI Listener. 

See “Configuring the MI Listener” on page 177.
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Setting up your Deployment (TCP or HTTPS)
To run Vusers or monitor servers over the firewall, configure your system 
according to one of the following configurations. Note that these 
configurations contain a firewall on each LAN. There may also be 
configurations where there is a firewall for the Over-Firewall LAN only.

➤ TCP Configuration

The TCP configuration requires every Performance Center agent machine 
behind the customer’s firewall to be allowed to open a port in the firewall 
for outgoing communication.  

Controller
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➤ HTTPS Configuration

In the HTTPS configuration, only one machine (the proxy server) is 
allowed to open a port in the firewall. Therefore it is necessary to tunnel 
all outgoing communications through the proxy server. 
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Configuring the Firewall to Allow Agent Access
You modify your firewall settings to enable communication between the 
machines inside the firewall and machines outside the firewall. 

TCP Configuration

The Performance Center agent attempts to establish a connection with the 
MI Listener using port 443, at intervals specified in the Connection Timeout 
field in the Agent Configuration dialog box. To enable this connection, 
allow an outgoing connection for HTTPS service on the firewall for port 443. 
The agent can then connect to the MI Listener, and the MI Listener can 
connect back to the agent. From this point on, the agent listens to 
commands from the MI Listener.

HTTPS Configuration

The Performance Center agent attempts to establish a connection with the 
MI Listener, using the proxy port specified in the Proxy Port field, and at 
intervals specified in the Connection Timeout field in the Agent 
Configuration dialog box. When the connection is established, the proxy 
server connects to the MI Listener. To enable this connection, allow an 
outgoing connection for HTTPS service on the firewall for port 443. The 
proxy server can then connect to the MI Listener, and the MI Listener can 
connect back to the agent through the proxy server. From this point on, the 
agent listens to commands from the MI Listener.
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Configuring the MI Listener
To enable running Vusers or monitoring over a firewall, you need to install 
the MI Listener on one or more machines in the same LAN as the Controller 
outside the firewall. For installation instructions, see, Chapter 2, “Installing 
Performance Center on Windows.”

Note: When installing the MI Listener:

➤ The MI Listener must be installed on a dedicated machine.

➤ Make sure that IIS is not running on the MI Listener or Monitor Over 
Firewall machine. IIS uses port 443 and will not allow the access required 
by the listening and monitoring processes.

To configure the MI Listener:

 1 Stop the Performance Center agent by right-clicking its icon in the system 
tray and selecting Close.

 2 Select Start > Programs > Performance Center > Advanced Settings > 
MI Listener Configuration, or open
<Performance Center root>\launch_service\bin\MILsnConfig.exe.
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 3 Set each option as described in the following table:

 4 Click OK to save your changes, Cancel to cancel them, or Use Defaults.

 5 Restart the Performance Center agent from Start > Programs > Performance 
Center.

 6 Make sure that port 443 is free on the MI Listener machine. 

Option Default Value Description

Check Client Certificates False Select True to request that the client 
send an SSL certificate when 
connecting, and to authenticate the 
certificate.

Private Key Password None The password that may be required 
during the SSL certificate 
authentication process.
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10
Running Vusers Over a Firewall

You can set up your Performance Center system to run Vusers over a 
firewall.

This chapter includes:

 ➤  Running Vusers Over a Firewall: Basic Steps on page 180

 ➤  Specifying MI Listeners for Running Vusers on page 181

 ➤  Configuring the Performance Center Agent on page 182

 ➤  Configuring Hosts to Run Vusers Over a Firewall on page 183
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Running Vusers Over a Firewall: Basic Steps

Important: Before you configure your system to run Vusers over the firewall, 
ensure that you have completed the configuration steps described in “Initial 
Configuration of the Over-Firewall System” on page 173.

To set up your system to run Vusers over a firewall:

 1 In the Performance Center Administration Site, specify the details of the 
MI Listener that will be used to run Vusers over the firewall. 

See “Specifying MI Listeners for Running Vusers” on page 181.

 2 Configure the Performance Center agent on each load generator machine 
that will be running over a firewall. 

See “Configuring the Performance Center Agent” on page 182.

Specify MI Listener details in Administration 
Site (Firewall Vusers Communicators)

Configure Performance Center Agent on 
Load Generator machine

Configure Load Generator Host on 
Administration Site

Running Vusers Over Firewall

Installation and Initial 
Configuration
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 3 In the Performance Center Administration Site, configure the relevant load 
generator hosts to run over a firewall. 

See “Configuring Hosts to Run Vusers Over a Firewall” on page 183.

Specifying MI Listeners for Running Vusers

In the Performance Center Administration Site, you specify one or more 
MI Listeners that will enable running Vusers over a firewall. 

To add an MI Listener for running Vusers:

 1 From the Performance Center left menu, select Resources > MI Listeners to 
open the MI Listeners page.

 2 In the Firewall Vusers Communicators area, click Add. The Add New 
MI Listener dialog box opens.
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 3 In the IP Address / Name box, type the IP address or DNS name of the 
MI Listener.

In some cases, you may want to use two different IP addresses for the same 
MI Listener—one address for internal communication with the Controller 
and a second address for public communication with a Load Generator 
located over a firewall. 

In this case, enter the internal IP address in the IP Address / Name box, and 
the public IP address in the Public IP Address / Name box.

 4 In the Comments box, type any comments that you want to note about the 
MI Listener.

 5 Click OK. The MI Listener is added to the table.

 6 Click Save at the bottom of the page.

Configuring the Performance Center Agent

On each load generator machine that will be running over a firewall, you 
configure the Performance Center agent to communicate with the MI 
Listener. 

For information on how to configure the Performance Center agent, see 
“Configuring the Performance Center Agent” on page 199.

Note: After you have configured the Performance Center agent on the load 
generator machine, you can edit the configuration settings from the 
Performance Center Administration Site. For more information, see the HP 
Performance Center Administrator’s Guide.
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Configuring Hosts to Run Vusers Over a Firewall

When you want to use a Performance Center host to run Vusers over a 
firewall, you need to configure the relevant hosts as load generators in the 
Performance Center Administration Site. 

Part of the process of configuring a Performance Center host, involves 
selecting a location for your host. For example, locations can be defined 
according to physical areas. The location also determines whether the host 
is located over a firewall.

Before you configure the host, you need to ensure that you have added a 
location over a firewall. When you are configuring a host to operate over a 
firewall, you select a location that is located over a firewall.

This section describes the basic steps of how to add a host as a load 
generator for running Vusers over a firewall. For detailed information about 
adding hosts in Performance Center, refer to the HP Performance Center 
Administrator’s Guide.

To add a Host to run Vusers over a firewall:

 1 Add a host location located over a firewall

 a In the Performance Center Administration Site, on the left menu, click 
Resources > Host Locations to open the Host Locations page

 b Click Add Host Location. The Add Host Location dialog box opens.

 c Type the location name. The name should have a logical connection to 
the host location. 
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 d Select Yes to indicate that the host is over the firewall. 

 e Click OK to add the location to the list.

 2 In the Performance Center Administration Site, on the left menu, click 
Resources > Hosts to open the Hosts page.
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 3 In the Hosts page, click Add Host. The Add New Host dialog box opens. 

 4 In the Name box, type the unique name of the host machine.

 5 In the OS Type box, select the operating system of the host.

 6 In the Location list, select a location located over a firewall.

 7 Select an MI Listener that will enable data collection.

➤ To automatically find the MI Listener connected to this load generator, 
click the Find MI Listener button next to the MI Listener list. The 
appropriate MI Listener is automatically selected in the list.
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➤ If no MI Listener was found, it means that the Load Generator 
Performance Center Agent has not been correctly configured to operate 
over a firewall. In this case, you need to manually select an MI Listener 
from the MI Listener list and then configure the Performance Center 
Agent on the load generator machine to operate over a firewall. 

For more information about configuring the Performance Center Agent 
to operate over a firewall, see “Configuring the Performance Center 
Agent” on page 199. 

 8 If the host is a standalone installation of the Load Generator, under 
Installation, select Standalone Load Generator.

If you selected UNIX as the operating system in the OS Type box, the 
Standalone Load Generator option is disabled.

 9 Because you selected a location over a firewall, under Purpose, Load 
Generator is automatically selected.

 10 In the Priority box, type a priority number.

 11 In the Host Pool list, select a host pool to which to assign the host. A host 
can be assigned to a single pool only. 

 12 In the State list, select the appropriate description of the host state (possible 
states are Operational, Unavailable, Resource Failure, or Maintenance).

 13 In the Comments box, type any relevant information about the host.

 14 You can configure the load generator to communicate with the Controller 
via SSL (Secure Socket Layer) by selecting Use SSL communication between 
this Load Generator and the Controller.

 15 To enable SiteScope monitoring of the host, select Enable SiteScope 
Monitoring. 

 16 If you selected a UNIX operating system, complete the Configuration for 
Unix section.

 17 Click Save to add the host. 

If you are prompted for the configuration user credentials, enter them and 
click OK. 
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11 
Monitoring Over a Firewall

You can set up your Performance Center system to monitor servers over a 
firewall.

This chapter includes:

 ➤  Monitoring Over a Firewall: Basic Steps on page 188

 ➤  Specifying MI Listeners for Monitoring over Firewalls on page 189

 ➤  Configuring the Performance Center Agent on page 189

 ➤  Configuring Monitor Settings on page 190

 ➤  Configuring the User Site to Receive Monitor Over  Firewall Information 
on page 195
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Monitoring Over a Firewall: Basic Steps

Important: Before you configure your system to monitor servers over a 
firewall, ensure that you have completed the configuration steps described 
in “Initial Configuration of the Over-Firewall System” on page 173.

To set up your system to monitor servers over a firewall:

 1 In the Performance Center Administration Site, specify the details of the 
MI Listener that will be used to monitor servers over the firewall.

See “Specifying MI Listeners for Monitoring over Firewalls” on page 189.

 2 Configure the Performance Center agent on each Monitor Over Firewall 
machine. 

See “Configuring the Performance Center Agent” on page 189.
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 3 Use the Server Monitor configuration tool to configure the servers to 
monitor and to define specific measurements that Performance Center 
collects for each monitored server.

See “Configuring Monitor Settings” on page 190.

 4 In the User Site, establish a connection between the tests you are running 
and the Monitor Over Firewall machines.

See “Configuring the User Site to Receive Monitor Over  Firewall 
Information” on page 195.

Specifying MI Listeners for Monitoring over Firewalls

In the Performance Center Administration Site, you specify one or more 
MI Listeners that will enable monitoring over a firewall.

To specify an MI Listener for collecting server monitor data:

 1 On the left menu, select Resources > MI Listeners to open the MI Listeners 
page.

 2 In the Firewall Monitoring Communicator area, in the IP Address / Name 
box, type the IP address or name of the MI Listener that is configured to 
collect server monitor data from over the firewall. 

 3 Click Save at the bottom of the page.

Configuring the Performance Center Agent

On each Monitor Over Firewall machine, you configure the Performance 
Center agent to communicate with the MI Listener. 

For information on how to configure the Performance Center agent, see 
“Configuring the Performance Center Agent” on page 199.
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Configuring Monitor Settings

You configure the monitor settings from the Monitor Over Firewall 
machine, using the Monitor Configuration tool. You select the type of 
monitors to run and the server whose resources you want to monitor, add 
the measurements to monitor for each server, and specify the frequency 
with which you want the monitored measurements to be reported.

To configure monitor settings:

 1 On the Monitor Over Firewall machine, choose Start > Programs > 
HP Performance Center > Advanced Settings > Monitor Configuration. For 
machines without the complete Performance Center installation, choose 
Start > Programs > Server Monitor > Monitor Configuration. The Monitor 
Configuration dialog box opens.
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 2 Click the Add Server button. The New Monitored Server Properties dialog 
box opens.

 3 In the Monitored Server box, type the name or IP address of the server 
whose resources you want to monitor. 

Note: To add several servers simultaneously, separate the server names or IP 
ranges with commas. For example, 255.255.255.0-255.255.255.5, server1, 
server2.

 4 From the Available Monitors list, select the monitors appropriate for the 
server being monitored. 
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 5 Click OK to close the New Monitored Server Properties dialog box. The 
Monitored Servers list is displayed in the Monitor Configuration dialog box. 

Performance Center displays default measurements for certain monitors in 
the Measurements to be Monitored section. You can specify the frequency at 
which Performance Center reports the measurement in the Measurement 
Properties section. 

 6 To add additional monitored servers to the list, repeat steps 2 through 5.

 7 To edit the monitor configuration properties for a server, click the Edit 
button. The Monitored Server Properties dialog box opens enabling you to 
edit the monitors for the server whose resources you are monitoring.

 8 Click Apply to save your settings.

Monitored

Monitors
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Cloning a Monitored Server’s Properties
To monitor the same properties on different server machines, you can clone 
a selected server’s properties using the Clone Monitored Server Properties 
dialog box.

To clone a monitored server’s properties:

 1 Open the Monitor Configuration dialog box.

 2 Right-click the server you want to clone, and select Clone. The Clone 
Monitored Server Properties dialog box opens.

 3 In the Monitored Server box, type the name or IP address of the cloned 
server you want to create. 

Tip: To create several cloned servers simultaneously, separate the server 
names or IP ranges with commas. For example, 255.255.255.5, server1, 
server2.
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 4 The Available Monitors list displays the monitors that were selected for the 
server being cloned. Select additional appropriate monitors for the cloned 
server. 

 5 Click OK to close the Clone Monitored Server Properties dialog box. The 
cloned server is displayed in the Monitored Servers list.

 6 Click Apply to save your settings.

Adding and Removing Measurements 
After you configure one or more server machines to monitor, you add 
measurements to monitor for each server. If Performance Center added 
default measurements, you can edit them as required.

To add a measurement to monitor:

 1 Open the Monitor Configuration dialog box.

 2 Select a server from the Monitored Servers list.

 3 Click the Add Measurement button. Select the appropriate monitor. A 
dialog box opens, enabling you to choose measurements for the monitor 
you selected.

 4 Select the measurements that you want to monitor, and click OK.

 5 Click Apply to save your settings.

To remove a measurement from the measurements list:

 1 Select the measurement, and click the Delete button. 

 2 Click Apply to save your settings.



Chapter 11 • Monitoring Over a Firewall

195

Configuring Measurement Frequency 
Once you have configured monitor measurements, you configure 
measurement frequency, that is, you set a schedule for reporting each 
measurement.

To set a schedule for reporting a measurement:

 1 In the Monitor Configuration dialog box, in the Measurement Properties 
section, select the configured server measurement you want to schedule.

 2 Specify the frequency at which you want Performance Center to report the 
measurement.

 3 Click Apply to save your settings.

Configuring the User Site to Receive Monitor Over 
Firewall Information

After you configure the monitors, you configure the Performance Center 
User Site to receive Monitor Over Firewall information during load tests.

To configure the User Site to receive Monitor Over Firewall information:

 1 On the Monitor Profile page, add the Monitor Over Firewall machines that 
can be accessed by load tests in this project. See “Adding Monitor Over 
Firewall Machines” on page 196.

 2 On the Load Test configuration page, select the Monitor Over Firewall 
machines you want to use in a specific load test. See “Selecting Monitor 
Over Firewall Machines for a Load Test” on page 197.

During a load test run you can edit Monitor Over Firewall machine 
information. See “Editing Monitor Over Firewall Machines During a Run” 
on page 198.
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Adding Monitor Over Firewall Machines
On the Monitor Profile page, you manage the Monitor Over Firewall 
machines that can be accessed by load tests in this project. 

To add a Monitor Over Firewall machine to a project:

 1 On the Monitor Profiles page, click Modify machine names. 

The Monitor Over Firewall Machines dialog box opens.

 2 In the Machine name box, type the name of the Monitor Over Firewall 
machine. 

 3 Click Add. The Monitor Over Firewall machine is added to the list.
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 4 Click Close. The name of the Monitor Over Firewall machine now appears 
on the Monitor Profiles page.

Selecting Monitor Over Firewall Machines for a Load Test
On the Load Test configuration page, you can select the Monitor Over 
Firewall machines that you want to use to monitor your load test. Before 
you can do this, you must ensure that you have added Monitor Over 
Firewall machines to the Performance Center project. See “Adding Monitor 
Over Firewall Machines” on page 196.

To select a Monitor Over Firewall machine for the load test:

 1 On the Load Test configuration page, click the Monitors tab.

 2 Click the Over Firewall Machines button. The Modify Agents List dialog box 
opens.

 3 Select the Monitor Over Firewall machines for the load test and click OK.

Your system is now configured to monitor Vusers over a firewall.

While the test is running, you can view graphs of the monitor over firewall 
data from the load test server monitors.
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Editing Monitor Over Firewall Machines During a Run
While the load test is running, you can change the status of a Monitor Over 
Firewall machine or add another monitor to the load test.

To modify the Monitor Over Firewall machines:

 1 On the Load Test Run page, click the Design button. The Load Test Design 
dialog box opens.

 2 Click Settings. The Settings dialog box opens. 

 3 Click the Server Monitors tab. Performance Center displays the Monitor 
Over Firewall machines that are monitoring the load test, as well as their 
connection status. 

➤ To connect or disconnect a Monitor Over Firewall machine, click the 
Connect/Disconnect button.

➤ To add a Monitor Over Firewall machine to the load test, select it from 
the Add Monitor Over Firewall machine list.

 4 Click OK.

 5 Click Close to close the Settings dialog box.
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12 
Configuring the Performance Center 
Agent

You can set up your Performance Center system to run Vusers and monitor 
servers over a firewall. As part of the process of setting up your Performance 
Center system to work over firewalls, you configure the Performance Center 
agent.

This chapter includes:

 ➤  About Configuring Performance Center Agents  Over the Firewall 
on page 200

 ➤  Configuring the Windows Performance Center Agent on page 200

 ➤  Configuring and Running the UNIX Performance Center Agent on page 203

 ➤  Agent Configuration Settings on page 205

 ➤  Checking Connectivity on page 208
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About Configuring Performance Center Agents 
Over the Firewall

As part of the process of setting up your Performance Center system to work 
over firewalls, you configure the Performance Center agent on each load 
generator machine that will be running over a firewall and on each Monitor 
Over Firewall machine.

You configure the Performance Center agent to communicate with the MI 
Listener. The MI Listener serves as a router between the Performance Center 
agent and the Controller.

Configuring the Windows Performance Center Agent

This section describes how to configure the Performance Center agent on 
Windows machines to communicate with the MI Listener.

Running Vusers Over Firewall

Installation and Initial 
Configuration

Monitoring Over Firewall

Configure Performance Center 
Agent on Load Generator 

machine
Configure Performance Center 
Agent on Monitor Over Firewall 

(MOFW) machine
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To configure the Performance Center agent on Windows machines:

 1 Select Start > Programs > Performance Center > Advanced Settings > 
Agent Configuration, or run 
<Performance Center root>\launch_service\bin\AgentConfig.exe.

The Agent Configuration dialog box opens.

 2 Select Enable Firewall Agent.

 3 Click Settings. The Agent Configuration dialog box displays a list of the 
settings.
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 4 Set each option as described in “Agent Configuration Settings” on page 205. 
Pay careful attention to the first three settings.

Important: When specifying the Local Machine Key, you must use the 
format hostname_locationname where hostname is the name of the host in 
the Hosts page of the Administration Site, and locationname is the name of 
the host location in the Host Location page.

 5 Click OK to save your changes, or Cancel to cancel them.

 6 When prompted, click OK to restart the Performance Center agent.

 7 Check the connection status between the Performance Center agent and the 
MI Listener. 

A green light illuminated next to the Performance Center Agent icon in the 
system tray indicates a successful connection between the agent and the 
MI Listener. A red light indicates that there is no connection between the 
agent and the MI Listener.

Notes:

➤ When you configure the Performance Center agent on Windows 
machines, the Remote Management agent, which enables you to manage 
remote machines from the Administration or User Site, is automatically 
configured with the same settings.

➤ After you have configured the Performance Center agent on the load 
generator machine, you can edit the configuration settings from the 
Performance Center Administration Site. For more information, see the 
HP Performance Center Administrator’s Guide.
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Configuring and Running the UNIX Performance Center 
Agent

Load generator hosts can be installed on UNIX machines. This section 
describes how to configure and run Performance Center agents on UNIX 
machines.

Note: As part of the process of configuring the Performance Center agent on 
UNIX machines, you also need to configure the Remote Management agent. 
The Remote Management agent enables you to manage remote machines 
from the Administration or User Site.

To configure the Performance Center agent on UNIX machines:

 1 Activate the firewall service for the Performance Center agent:

 a Open <Performance Center root folder>/dat/br_lnch_server.cfg in a text 
editor.

 b In the Firewall section, set FireWallServiceActive to 1 and save your 
changes.

 2 Activate the firewall service for the Remote Management agent:

 a Open <Performance Center root folder>/al_agent/dat/
br_lnch_server.cfg in a text editor.

 b In the Firewall section, set FireWallServiceActive to 1 and save your 
changes.

 3 Run agent_config from the <Performance Center root folder>/bin directory 
and enter the agent configuration settings (see “Agent Configuration 
Settings” on page 205).

Note: When you set the agent configuration settings, they are applied to 
both the Performance Center and Remote Management agents.
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 4 Restart the Performance Center agent for the configuration changes to take 
effect.

 a To stop the Performance Center agent, run the following command from 
the <Performance Center root folder>/bin directory:

 

 b To start the Performance Center agent, run the following command from 
the <Performance Center root folder>/bin directory:

 

Note: When the Performance Center agent is configured to run over a 
firewall, and the agent is connected to the MI Listener, a file called 
<local_machine_key>_connected_to_MI_Listener is created in the temporary 
directory of the Performance Center agent machine. This file is deleted 
when the Performance Center agent disconnects from the MI Listener.

 5 Restart the Remote Management agent for the configuration changes to take 
effect.

 a To stop the Remote Management agent, run the command from the 
<Performance Center root folder>/al_agent/bin directory:

 

 b To start the Remote Management agent, run the following command 
from the <Performance Center root folder>/al_agent/bin directory:

 

m_daemon_setup -remove

m_daemon_setup -install 

al_daemon_setup -remove 

al_daemon_setup -install 
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Agent Configuration Settings 

The following table provides an explanation of the agent configuration 
settings:

Setting Default Value Description

MI Listener name none The name, full name, or IP address 
of the MI Listener.

Local Machine Key none A string identifier used to establish 
a unique connection between the 
Controller host and the agent 
machine, via the MI Listener 
machine.

When configuring to monitor 
over a firewall, you can enter any 
logical name, using lowercase 
letters only.

When configuring to Vusers over 
a firewall, you must use the 
format hostname_locationname 
where:

➤ hostname is the name of the 
host as found on the Hosts page 
of the Administration Site

➤ locationname is the name of the 
host location as found on the 
Host Location page of the 
Administration Site.

Connection Timeout 
(seconds)

20 seconds The length of time you want the 
agent to wait before retrying to 
connect to the MI Listener 
machine. If zero, the connection 
is kept open from the time the 
agent is run.

MI Listener User Name none The user name needed to connect 
to the MI Listener machine.
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MI Listener Password none The password needed to connect 
to the MI Listener machine.

Server Domain none The domain name needed to 
connect to the MI Listener 
machine. This field is required 
only if NTLM is used.

Connection Type - 
TCP/HTTP

TCP Select either TCP or HTTP, 
depending on the configuration 
you are using.

Connection Type - 
HTTP Proxy Name

none The name of the proxy server. This 
field is mandatory if the 
Connection Type setting is HTTP.

Connection Type -
HTTP Proxy Port

none The proxy server connection port. 
This field is mandatory if the 
Connection Type setting is HTTP.

Connection Type - 
HTTP Proxy User Name

none The user name of a user with 
connection rights to the proxy 
server.

Connection Type - 
HTTP Proxy Password

none The password of the user with 
connection rights to the proxy 
server.

Connection Type - 
HTTP Proxy Domain

none The user’s domain if defined in 
the proxy server configuration. 
This option is required only if 
NTLM is used.

Use Secure Connection 
(SSL)

disabled Enable to connect using the 
Secure Sockets Layer protocol.

Setting Default Value Description



Chapter 12 • Configuring the Performance Center Agent

207

Use Secure Connection 
(SSL) - Check Server 
Certificates

none Authenticates the SSL certificates 
that are sent by the server. Select 
Medium to verify that the server 
certificate is signed by a trusted 
Certification Authority. Select 
High to verify that the sender IP 
matches the certificate 
information. This setting is 
available only if Use Secure 
Connection is set to True. 

Use Secure Connection
(SSL) - Private Key 
Password

none The password that might be 
required during the SSL certificate 
authentication process. This 
option is relevant only if the 
Client Certificate Owner option is 
enabled.

Use Secure Connection
(SSL) - Use Client 
Certificate

disabled Enable to load the SSL certificate 
(if required by the server to allow 
the connection to be made). This 
option is relevant only if the Use 
Secure Connection option is 
enabled.

Setting Default Value Description
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Checking Connectivity

To run Vusers or monitor servers over a firewall, you must be able to 
establish a connection between the Performance Center agent, MI Listener, 
and the Controller machine. 

If you encounter connectivity problems after installing and configuring all 
the necessary components, check the table below for troubleshooting tips. 

Check Solution

To check that the Firewall 
service was activated on the 
agent machine:

There should be a traffic light to the right side 
of the Performance Center Agent icon on the 
machine running/monitoring Vusers over a 
firewall. If there is no traffic light, this 
indicates that the FirewallServiceActive=1 is 
not set in the [FireWall] section of the Agent 
Settings. For details, see “About Configuring 
Performance Center Agents  Over the 
Firewall” on page 200.

To check that port 443 is open: On the agent machine, open a command 
prompt window, and type the following: 
telnet <MI_Listener_IP>443. 
For example: telnet 111.111.111.1111 443. 
If port 443 is open, a new Telnet window will 
open. If port 443 is not open, contact your 
network administrator. 

To check that port 443 is 
available:

If a Web server is running on the MI Listener 
or Monitor Over Firewall machine, port 443 
will not allow the access required by the 
listening and monitoring processes. Contact 
your network administrator to change the 
Web server port.
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To check connectivity between 
the agent and the MI Listener, 
when running the Performance 
Center agent as a service:

If there is a red light to the right of the 
Performance Center agent icon when running 
the Performance Center agent as a service, do 
the following:

➤ Check that port 443 is open. See above.

➤ Check that the Agent Settings and Agent 
Configuration are correctly set. For details, 
see “About Configuring Performance 
Center Agents  Over the Firewall” on 
page 200.

➤ Run the agent as a process by launching 
Installation>\Launch_service\bin\magent
proc.exe. If you are successful, this 
indicates an authentication issue with the 
Performance Center Agent Service. Browse 
to the Service > Performance Center Agent 
Service and change the properties of this 
service to System User Account, or provide 
the username and password of a user who 
has administrative privileges on this 
machine.

Check Solution
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13
Troubleshooting Installation and 
Upgrade

This chapter provides information on troubleshooting problems that occur 
during the Performance Center installation and configuration process.

This chapter includes:

 ➤  Error: Method ~ of object ~ Failed During Installation on page 214

 ➤  DllHost.exe – Application Error on page 216

 ➤  Failure to Retrieve License Key on page 217

 ➤  PCWS Folder Not Installed Correctly on page 218

 ➤  Performance Center Does Not Load - Error 500 on page 218

 ➤  Error on Page During System Configuration on page 219

 ➤  Installation Does Not Recognize Prerequisite Software on page 219

 ➤  Performance Center Prerequisite Software on page 221
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Error: Method ~ of object ~ Failed During Installation

Error message: Operation terminated. Error description: Method '~' of object 
'~' failed.

Troubleshooting

 1 Check the server’s System Event log for W3SVC errors.

 2 Verify the configured identity for the IWAM_<SERVER NAME> account.

 3 Make sure that the password for the IWAM account is synchronized in all 
three locations:

➤ Internet Information Server (IIS) metabase

➤ Local Users and Groups (Windows 2000)

➤ Component Services (Windows 2000)

For more information on obtaining or setting the account password, see: 
http://support.microsoft.com/default.aspx?scid=kb;en-us;297989.

 4 Verify that the COM+ service is running.

 5 Verify that the COM+ service is correct:

 a Select Start > Run and type dcomcnfg to open the COM+ manager.

 b Expand Component Services.

 c Expand Computers.

 d Right click My Computer and select Properties. The My Computer 
Properties dialog box opens.

 e Click the MSDTS tab.

 f Click Security Configuration. The Security Configuration dialog box 
opens.

 g Ensure that Enable XA Transactions is not selected.

 h Click OK to close the Security Configuration dialog box.

 i Click OK to close the My Computer Properties dialog box.

http://support.microsoft.com/default.aspx?scid=kb;en-us;297989
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 6 If the problem persists, follow the steps below depending on your version of 
Windows:

Windows 2003 SP2:

 a If this fails, re-image the machine as follows:

➤ Reinstall Windows.

➤ Install IIS.

➤ Install SP1.

➤ Install SP2.

Windows 2000 SP4:

 a Open the command line (Start > Run and type cmd).

 b From the <Drive>\inetpub\AdminScripts folder, enter the following 
command:

 7 If you receive an error message similar to the following:

This might occur because the password for the IWAM_computer account is 
mismatched between the Windows Active Directory and the IIS metabase. 
Therefore, Synciwam.vbs cannot synchronize the processes to the 
IWAM_computer account as needed. It might also occur if the 
IWAM_computer account is locked out or disabled.

You need to match the password that is used by the IWAM_computer 
account in the IIS metabase with the password that is used by the 
IWAM_computer account in Active Directory.

For more information see: http://support.microsoft.com/kb/269367

cscript.exe synciwam.vbs -v

Updating Applications: 
Name: IIS Out-Of-Process Pooled Applications Key:
{3D14228D-FBE1-11D0-995D-00C04FD919C1}
Error: 80110414

http://support.microsoft.com/kb/269367
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DllHost.exe – Application Error

Error message: Operation terminated. DllHost.exe – Application Error.

Troubleshooting

(IIS 5 only) Change the application protection level in the Internet Services 
Manager from High (isolated) to Low (IIS Process).

 1 Select Start > Programs > Administrative Tools > Internet Services Manager 
to open the Internet Information Services dialog box.

 2 In the Tree directory, expand Default Web Site and right-click Admin. Click 
Properties to open the Admin Properties dialog box.
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 3 Select the Virtual Directory tab, and in the Application Protection list, select 
Low (IIS Process).

 4 After installation, change the Application Protection back to High (Isolated) 
by repeating the above steps and clicking High (Isolated) in step 3.

Failure to Retrieve License Key

Problem description: Retrieve License Key fails. This may occur as a result of 
problems with the .NET Framework installation.

Troubleshooting

Repair the .NET Framework installation as follows:

 1 Select Start > Run. 

 2 Enter the following command:

c:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -i
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PCWS Folder Not Installed Correctly

Problem description: You receive an error on the license page of the 
Administration Site, or the load test fails to run.

Troubleshooting

You may need to reinstall the PCWS folder. To install the PCWS folder and 
restore the IIS configuration, run the following command:

Performance Center Does Not Load - Error 500

Problem description: After upgrading the database client, Performance 
Center does not load the Web browser and returns Error 500.

Troubleshooting:

There might be a permissions problem between IIS and the Oracle home 
directory.

➤ Make sure oracle_home is well defined in the HKLM\Software\Oracle 
directory.

➤ Make sure the IWAM_<machine> user has execute and write permissions 
in the Oracle home directory.

➤ Make sure tnsnames.ora and sqlnet.ora are defined properly.

<Performance Center installation directory>\bin\ AdminInstaller.exe" WebService 
IUSR_METRO MIOrchid#1
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Error on Page During System Configuration

Problem description: After you save your initial system configuration 
settings in the Administration Site, you receive an error in the Log area of 
the Initial System Configuration page stating that the page cannot be 
displayed.

Troubleshooting

During system configuration, IIS is reset on the Administration Site Server. 
When the File Server is installed on the same machine as the Administration 
Site Server, Error on Page is sometimes displayed as a result of the IIS reset.

Even though this error is displayed, the system configuration is still saved 
successfully. 

To continue configuring your system, log on to the Administration Site 
again and continue working.

Installation Does Not Recognize Prerequisite Software

Problem description: Before you can install Performance Center, specific 
prerequisite software (for example, .NET Framework 2.0) needs to be 
installed on your machine. Without this prerequisite software, Performance 
Center will not function properly. During installation, if the prerequisite 
software is not already installed on your machine, Performance Center lists 
the prerequisite software that you need to install and enables you to 
automatically install the software from the Performance Center disk. 

If the prerequisite software has been installed on your machine in an 
irregular way, Performance Center may not detect the installation and will 
not allow you to proceed with the installation.

Troubleshooting

If you are certain that you have correctly installed all the prerequisite 
software, you can skip the prerequisite software check in the installation 
procedure.
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Important: Skipping the prerequisite software check is not recommended 
practice, because Performance Center may not function properly as a result. 
The prerequisite software check should only be skipped under very limited 
circumstances, and after consultation with Customer Support.

To launch the Performance Center installation without the prerequisite 
software check, run the following command:

msiexec.exe /i HP_Performance_Center.msi SKIP_PREREQUISITE_CHECK=1
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Performance Center Prerequisite Software

Before you can install Performance Center, specific prerequisite software (for 
example, .NET Framework 2.0) needs to be installed on your machine. 
During installation, Performance Center checks whether the prerequisite 
software is installed on your machine. If anything is not installed, 
Performance Center enables you to automatically install the software from 
the Performance Center disk.

The following table provides a list of the prerequisite software and how 
Performance Center detects whether the software is installed.

Prerequisite 
Software

Machines Means of detecting

.NET 
Framework 2.0

➤ All Performance Center 
machines

➤ VuGen Standalone

➤ Analysis Standalone

Searches the registry key:

HKLM\\Software\\Microsoft\\NET 
Framework 
Setup\\NDP\\v2.0.50727

Microsoft Data 
Access 
Components 
(MDAC) 2.8 
SP1

➤ All Performance Center 
machines

➤ VuGen Standalone

➤ Analysis Standalone

Searches the registry key:

HKLM\\Software\\Microsoft\\Data
Access 

Microsoft Core 
XML Services 
(MSXML) 6.0

➤ All Performance Center 
machines

➤ VuGen Standalone

➤ Analysis Standalone

Queries the existence and 
version of: 
%systemroot%\system32\msxml
6.dll

Microsoft 
Visual C++ 
2005 
Redistributable 
Package (x86)

➤ All Performance Center 
machines

➤ VuGen Standalone

➤ Analysis Standalone

Queries the MSI manager for 
one of the GUIDs below:

{A49F249F-0C91-497F-86DF-B
2585E8E76B7}

{437AB8E0-FB69-4222-B280-A
64F3DE22591} 
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Microsoft 
Windows 
Installer 3.1

➤ All Performance Center 
machines

➤ VuGen Standalone

➤ Analysis Standalone

Looks for one of the two:

➤ Registration of the 
WindowsInstaller. 
Installer.com object version 
3 or higher 

➤ MSI.dll version 3 or higher 
in the %systemroot% 

Web Services 
Enhancements 
(WSE) 3.0 for 
Microsoft .NET 
Redistributable 
Runtime MSI

➤ All Performance Center 
machines

➤ VuGen Standalone

Queries the MSI manager for 
the GUID: 

{E3E71D07-CD27-46CB-8448-1
6D4FB29AA13} 

Web Services 
Enhancements 
(WSE) 2.0 SP3 
for Microsoft 
.NET 
Redistributable 
Runtime MSI

➤ All Performance Center 
machines

➤ VuGen Standalone

Runtime installation GUID 
{F3CA9611-CD42-4562-ADAB-A
554CF8E17F1} 

Full installation GUID 

{6F 
396FFB-CC3A-4335-BC0B-2AE
F38F4492C} 

Internet 
Information 
Services (IIS)

➤ All Performance Center 
machines

(In a machine used as load 
generator the IIS can be 
uninstalled after installation)

HKLM\\SOFTWARE\\Microsoft\\I
netStp 

Looks for both Major and 
Minor numbers. 

Supports versions 6.0, 5.1 and 
5.0

Prerequisite 
Software

Machines Means of detecting
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14
Troubleshooting Databases

This chapter provides information on troubleshooting problems that occur 
with database in the Performance Center system.

This chapter includes:

 ➤  Login to Oracle Database Server Hangs on page 223

 ➤  Login to Database Server Fails on page 226

 ➤  Database/User Schema Creation Fails on page 228

 ➤  Warning Message Received During MS-QL Database Migration on page 229

 ➤  Conflict Warnings Received During Database Migration on page 229

Login to Oracle Database Server Hangs

Error message: Trying to log on to database server.

Troubleshooting

➤ Option 1 (IIS 5 only): Set the Application Protection level to High (isolated)

Make sure that the Application Protection level is set to High (isolated) in 
the Internet Services Manager in both the Administration Site and User Site. 
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To set the application protection level: 

 1 Select Start > Programs > Administrative Tools > Internet Services Manager. 
The Internet Information Services dialog box opens.

 2 In the Tree directory, expand Default Web Site and right-click Admin. Click 
Properties to open the Admin Properties dialog box.

 3 Click the Virtual Directory tab.
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 4 In the Application Protection box, select High (Isolated).

 5 Repeat steps 2 through 4 for the User Site. In step 2, right-click LoadTest 
instead of Admin.

Option 2: Set the Correct Permissions Level for the IWAM_<SERVER> user

Problems with loggin on might be caused by a permissions level problem 
with the IWAM_<SERVER> user. By default, this account is set to the Guest 
permissions level. However, the IWAM_<SERVER> user must have read/
execute privileges on the Oracle home directory and all of its sub-directories.

To set the correct permissions level: 

 1 In Windows Explorer, right-click the Oracle home directory and select 
Properties.

 2 Click the Security tab.

 3 Click Add and add the IWAM_<SERVER> user.

 4 Check Read & Execute.

 5 Click OK.
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Login to Database Server Fails

Error message: Operation terminated. Error description: Login to the 
database server failed. Check if user name and password are correct.

Troubleshooting

 1 Verify that the database server host name, type, user name, and password 
are correct. Consult your database administrator if you are unsure. 

 2 Check whether you can connect to the database server from the 
Administration Site server using the command line SQL client:

➤ For MS SQL Server:

For example:

If your Microsoft SQL Server is configured with integrated security, make 
sure that the Microsoft SQL Server has an operating system account for 
IUSR_METRO (password: MIOrchid#1), and is allowed access to the 
database. IUSR_METRO is the default account under which the 
HP Performance Center Web server runs.

➤ For Oracle Server:

For example:

If the above command fails, check your TNS entry in the <Oracle 
installation directory>\network\admin\tnsnames.ora file.

% osql –U <username> -P <password> -S <serverID>

% osql –U sa –P manager –S DBSERVER\LRTCDB

% sqlplus <username>/<password>@<connect_string>

% sqlplus system/manager@LRTCORA
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An example of a TNS entry is shown below:

 3 Test the ADODB connectivity to the database  by downloading the 
TcIN_AdoDBTester.exe utility from the HP Software Support site. After you 
log in to the support site, click Knowledge Base, select LoadRunner 
TestCenter, and search for ID39475. 

 a Update the username, password, and server fields in the connection 
string:

➤ For MS SQL Server, use the Provider=SQLOLEDB.1;… connection 
string.

➤ For Oracle Server, use the Provider=MSAORA.1;… connection string.

 b Set a valid SQL statement (based on current database tables).

 c Execute the statement and check the response. If an error occurs, address 
the error message appropriately.

 4 If you are working with Oracle Server, check that Oracle Client is installed 
properly:

 a Check whether the ORACLE_HOME registry entry under 
[HKEY_LOCAL_MACHINE\Software\Oracle] is correct. It should be 
pointing to the Oracle Client installation.

 b Remove SQLPLUS.EXE from the <HP Performance Center installation 
directory>\DB directory.

 5 Verify that the MDAC version is 2.8 SP1. 

LRTCORA =
(DESCRIPTION =
      (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = TCDBSERVER)(PORT 1521))
      )
(CONNECT_DATA =
            (SERVICE_NAME =LRTCORA)
)

)
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 6 Verify that the database or user schema was actually created by checking 
whether the db_results.txt file exists in the %temp% directory of the 
Administration Site server. Note that this file is available only after system 
configuration. In addition, you can check whether the MI_LRDB database or 
user schema exists by logging in to the database/user schema.

Note: If you are able to log on to the User Site after system configuration, 
the database or user schema was most likely created properly.

Database/User Schema Creation Fails

Problem description: You cannot create an HP Performance Center database 
or user schema.

Troubleshooting

Try to create the database or user schema by running the SQL files located in 
the DbSetup directory of the Administration Site server.

➤ For MS SQL Server, run TestCenter.sql to create the database and 
InitDefinitions.sql to initialize the tables.

➤ For Oracle Server, run TC_oracle.sql to create the user schema and 
InitDataOracle.sql to initialize the tables.
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Warning Message Received During MS-QL Database 
Migration

Problem description: The following warning message appears in the log file 
<DB_Migration_directory>\PC_V9_1.log when performing an MS-QL 
database migration:

Troubleshooting

This message is related to a size limit that is related to the Project Options. 
Since this size limit will not be utilized, you can disregard this message.

Conflict Warnings Received During Database Migration

Problem description: The following messages might appear in the log file 
<DB_Migration_directory>\PC_V9_0.log when performing a database 
migration:

Troubleshooting

These messages appear when performing database migration of Performance 
Center 8.14 and earlier. These warnings relate to features that are no longer 
relevant in the current version of Performance Center. You can disregard 
these messages.

Warning: The table 'Companies' has been created but its maximum row size (8227) 
exceeds the maximum number of bytes per row (8060). INSERT or UPDATE of a row in 
this table will fail if the resulting row length exceeds 8060 bytes.

DELETE statement conflicted with COLUMN REFERENCE constraint 
'FK_ResultTransactions_RunPublishedResults'.
The conflict occurred in database 'MI_LRDB', table 'DashboardResultTransactions', 
column 'RunResultId'.

DELETE statement conflicted with COLUMN REFERENCE constraint 
'FK_GoalTransactions_TestGoals'. 
The conflict occurred in database 'MI_LRDB', table 'DashboardGoalTransactions', 
column 'TestGoalId'.
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